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1 Welcome to the Clay Tablet Connector for Sitecore 1.1 The Translation Lifecycle

1 Welcome to the Clay Tablet Connector for Sitecore

Welcome to the Clay Tablet Connector for Sitecore ("Connector"). The Connector enables you to automate
sending and retrieving content from Sitecore, which dramatically reduces the effort required to create,
maintain, and publish Web content in multiple languages.

If you have the Special Edition for Lionbridge Freeway, you can automate sending and retrieving content
from Sitecore directly to and from Freeway.

If you have the Special Edition for Lionbridge onDemand, you can automate sending and retrieving content
from Sitecore directly to and from onDemand.

1.1 The Translation Lifecycle

The translation lifecycle is the broad process of selecting content, sending it out for translation, and then
receiving the translated content back from translation.

This set of steps usually fits inside a larger, more general process called the content lifecycle, which is the
process of creating, reviewing, editing, approving, and publishing content.

When you consider the translation lifecycle and the content lifecycle together, you have the global content
value chain, which is the strategy for managing multilingual content.

The content lifecycle and the translation lifecycle are impacted by the workflow steps you implement in Sitecore
to manage multilingual content.

Remember that localizing content is a subset of steps in the broader content lifecycle. This willimprove your
focus on key localization considerations, improve processes, and keep all content stakeholders included.
Together, this results in better content management.

1.2 How the Connector Helps You Manage Your Translation Lifecycle

The Clay Tablet Connector for Sitecore ("Connector") is a plug-in module for Sitecore. It provides a range of
features and user interface enhancements in Sitecore that enable you to select, send, monitor, and retrieve
content for translation into any language Sitecore supports.

These features automate the process, which dramatically reduces the effort and time required to export and re-
import content that needs to be localized. This is very helpful when translating large volumes of content or
ensuring that translated content is quickly re-imported to meet deadlines.

When you use the Connector, you manage your translation lifecycle entirely from within Sitecore:

1. The Connector exports your content from Sitecore in either XML or HTML format and delivers these content
files to the central, hosted Clay Tablet Platform.

2. The Clay Tablet Platform delivers your content to your translation provider, based on routing rules that your
company chooses and Clay Tablet Technologies implements.
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3. When the translated content is ready, the Clay Tablet Platform retrieves it from your translators and delivers
it to the Connector.

4. The Connector automatically re-imports the content into the correct location in Sitecore.

You can then review, revise, reject, or publish the translated content as needed.

Note: Neither the Connector nor the Clay Tablet Platform performs any translation. Similarly, Clay Tablet
Technologies does not provide any translation services. Your company chooses the translation provider that
performs the translation.

1.3 Using this Guide

Purpose of this guide

This guide describes how to use the Clay Tablet Connector for Sitecore ("Connector") to manage your
translation lifecycle. It describes how to send Sitecore items for translation and receive them back from
translation.

Who should use this guide

This guide is intended for content editors, project, marketing, localization or translation managers, or others
who are responsible for creating, editing, or approving content for translation that resides in your Sitecore CMS.
This guide is also useful for translation providers who receive content from your Sitecore CMS, because it
describes your company's translation management process.

What your company setup should be

This document assumes that:
B Your company already has a functioning instance of Sitecore.

B The Clay Tablet Connector for Sitecore ("Connector") has been implemented, configured, and tested on your
Sitecore CMS.

B (Clay Tablet Technologies has set up the Clay Tablet Platform to send content to your translation providers.

If Lionbridge is your company's translation provider, it assumes that either Freeway or onDemand is already set
up for your company.

What you should already know

This document assumes that:

B You are familiar with the Connector's configuration for your Sitecore CMS, and the reasons for choosing
certain configuration options. This is important because your company's configuration determines which
features are available.

B You have a strong working knowledge of the Sitecore Content Editor.
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1.3 Using this Guide

B You are familiar with the basic concepts of the Sitecore Workflow features. This is crucial, because workflow is
a core concept required to use the Connector.

B You are familiar with your company's translation process and requirements.

B You have valid user credentials to log into Sitecore.

B You have the required permissions to access the Connector functionality described in this guide.

Note: Not all the features described in this guide may be available. Feature availability depends on both your
company's Connector setup and the roles to which you are assigned. If you cannot access functionality that
you need, contact your company's Sitecore administrator.

How this guide is organized

This guide contains the following chapters:

Chapter

Description

"Welcome to the Clay
Tablet Connector for
Sitecore" on page 5

A brief description of the Clay Tablet for Sitecore solution and how it fits into the
translation lifecycle. It also includes information about this guide and Clay
Tablet Technologies Support contact information.

"Getting Started with the
Clay Tablet Connector for
Sitecore" on page 11

How to get started and an overview of the Clay Tablet Connector for Sitecore
interface and key features.

"Creating Content for
Translation" on page 21

How to create, adapt, and filter Sitecore content so that you can send it out for
translation using the Clay Tablet Connector for Sitecore.

"Sending Content to
Translation" on page 34

How to use the Clay Tablet Connector for Sitecore to send out content for
translation.

"Monitoring Translation
Status" on page 69

How to monitor the translation status of content that you sent out for
translation.

"Reviewing Translated
Content" on page 90

How to review and publish translated content after it automatically returns
from the translation provider to the Sitecore CMS.

"Post-Translation
Features" on page 93

How to perform post-translation tasks, including synchronizing translations,
requesting a translation correction, updating a remote TM (translation
memory) server, and clearing the translation backup data.

How to find out more about Clay Tablet Connector for Sitecore

For information on installing and configuring the Clay Tablet Connector for Sitecore, read the Clay Tablet
Connector for Sitecore Installation and Configuration Guide.
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1 Welcome to the Clay Tablet Connector for Sitecore 1.4 How to Contact Clay Tablet Support

Documentation conventions

This guide uses the following conventions:

Convention | Description

Bold Highlights screen elements such as buttons, menu items, and fields.

Courier Highlights input, file names, and paths.

Italics Highlights terms to emphasize, variables, or document titles.

> Indicates a menu choice. For example, "Select Sitecore Desktop > All Applications > CTC
Translation > Translation Filter."

1.4 How to Contact Clay Tablet Support

Email @: support@clay-tablet.com
Telephone: +1-416-363-0888

You can submit a support ticket either:

B by email
B from the Clay Tablet Zendesk page, using your web browser
To submit a support ticket:

1. Do one of the following:

# Email support@clay-tablet.com, and cc (carbon copy) anyone to include in the ticket correspondence.

Important: Include the information and attachments in your email that are listed in the sub-sections
below.

# Create aticket in Zendesk:

a. Open the Clay Tablet Zendesk page in your browser: https://claytablet.zendesk.com.

b. Signin to Zendesk. If you do not have sign-in credentials, see "To view and update your support ticket
in Zendesk:" below.

Important: Include the information and attachments that are listed in the sub-sections below.

c. Click Submit a request.
d. Inthe CCsfield, add anyone to include in the ticket correspondence.

Zendesk automatically creates a ticket and responds to everyone included in the cc field.

2. Everyonein the original cc receives updates unless they request to be removed from the ticket.
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1 Welcome to the Clay Tablet Connector for Sitecore 1.4 How to Contact Clay Tablet Support

Important: Check your email spam folder (especially first-time Zendesk users) as sometimes email
notifications from Zendesk are marked as spam.

When the issue is resolved, Clay Tablet closes the ticket.

Information to include in the support ticket:

B client name

B CMS or content system name and version
B Connector or App version installed

B name of job for which the issue occurs

B date of job submission

B detailed description of the issue

B any error text—copy and paste, if applicable

Files to attach to the support ticket:

B CMS log files for the date the issue occurred
B Clay Tablet log files for the date the issue occurred

B screen capture of theissue

To view and update your support ticket in Zendesk:

Important: You must log into Zendesk to view your support tickets there.

1. Open the Clay Tablet Zendesk page in your browser: https://claytablet.zendesk.com.

2. Inthetop-right corner, click Sign in, and enter your credentials.

Note: If you do not have sign-in credentials yet, then click either Sign up or Get a password, and follow the
onscreen instructions.
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1 Welcome to the Clay Tablet Connector for Sitecore 1.4 How to Contact Clay Tablet Support

Sign in to Clay Tablet Technologies

MNew to Clay Tablet Technologies

Have you emailed us

3. Aftersigningin, click My activities to view the tickets you opened or where you are cc’d.

4. To update tickets, you can reply or attach files.

For more information, refer to "Submitting and tracking support requests" in Zendesk's Help Center guide for

end-users, at: https://support.zendesk.com/hc/en-us/articles/203664386-Help-Center-guide-for-agents-and-
end-users.

Important: Zendesk refers to a support ticket as a support request. These terms are interchangeable.
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2 Getting Started with the Clay Tablet Connector for Sitecore 2.1 Key Features

2 Getting Started with the Clay Tablet Connector for Sitecore

The Connector supports the Mozilla Firefox and Google Chrome web browsers. The Connector supports
Microsoft Internet Explorer 11 with Sitecore 7 and 8.

To access the Connector, log into Sitecore.

Tip: To view the Connector user interface in Japanese, change your language setting in Sitecore. For detailed
instructions, see https://doc.sitecore.net/sitecore_experience platform/content authoring/the editing
tools/change your personal settings. Note that your Sitecore administrator must install the Connector
language pack to support viewing the Connector user interface in Japanese.

2.1 Key Features

The Clay Tablet Connector for Sitecore (the "Connector") has the following key features:
B "Multiple Ways of Sending Content for Translation" on page 11
B "Optimizing Translation Costs (Use Local TM)" on page 12

B "Selecting a Translation Provider" on page 12

2.1.1 Multiple Ways of Sending Content for Translation

B There are the following multiple ways to send content items out for translation:

# Send a single content item for translation from the Sitecore Content Editor. For details, see "Submitting a
Content Item for Translation using the Content Editor" on page 35.

# Send a single content item for translation from the Sitecore Page Editor (Sitecore 6 and 7) or the Sitecore
Experience Editor (Sitecore 8). For details, see "Submitting Content for Translation from the Page Editor
or the Experience Editor" on page 41.

# Send multiple content items using the Bulk Translation wizard. You can filter to exclude content, and
send out requests for translations of one target language at a time. For details, see "Sending Multiple
Content Items for Translation" on page 46.

B Depending on your company's Connector configuration, you may be able to send content out for translation
either immediately or via a queue.

i Send content immediately to the translation provider.

# Send content via the Translation Queue, which enables you to group items together by project and
priority, target language, and require additional approval. For details, see "Submitting Content for
Translation from the Translation Queue" on page 62.

Clay Tablet Connector for Sitecore User Guide Page 11
Version 3.10.0 June 14, 2017


https://doc.sitecore.net/sitecore_experience_platform/content_authoring/the_editing_tools/change_your_personal_settings
https://doc.sitecore.net/sitecore_experience_platform/content_authoring/the_editing_tools/change_your_personal_settings

2 Getting Started with the Clay Tablet Connector for Sitecore 2.2 The Connector at a Glance

2.1.2 Optimizing Translation Costs (Use Local TM)

The Use Local TM feature helps you reduce translation costs, by reducing the quantity of content that
Connector sends to translation providers. With this feature, the Connector sends only changed content fields
out for translation. To do this, it checks each field of the source version for any content changes.

However, this feature needs Connector translation backup data, and it increases the Connector processing time
before sending out the items for translation. For information on enabling Connector translation backup data,
refer to the Clay Tablet Connector for Sitecore Installation and Configuration Guide.

This feature is available:

B by selecting the Use Local TM check box in the Translation Options page of the Bulk Translation wizard, as
described in "Sending Multiple Content Items for Translation" on page 46.

B by selecting the Use LocalTM check box in the Automatic Item Export for Translation dialog box, as
described in "Submitting a Content Item for Translation using the Content Editor" on page 35 and
"Submitting Content for Translation from the Page Editor or the Experience Editor" on page 41.

2.1.3 Selecting a Translation Provider

If your company has multiple translation providers, your company's Connector setup may enable you to select
which one to use when you send out items for translation.

This feature is available:

B in the Translation Queue, as described in "Submitting Content for Translation from the Translation Queue"
on page 62.

B in the Translation Options page of the Bulk Translation wizard, as described in "Sending Multiple Content
Items for Translation" on page 46.

B when sending an individual content item for translation from the Sitecore Content Editor, as described in
"Submitting a Content Item for Translation using the Content Editor" on page 35.

B when sending an individual content item for translation from the Sitecore Page Editor, as described in
"Submitting Content for Translation from the Page Editor or the Experience Editor" on page 41.

2.2 The Connector at a Glance

You access the Clay Tablet Connector for Sitecore ("Connector") directly from the Sitecore user interfaces—from
the Content Editor, the Experience Editor (Sitecore 8 only), the Page Editor (Sitecore 6 and 7 only), and the
Desktop (Sitecore 6 and 7 only).

Note: Not all Connector features are available in all Sitecore user interfaces.
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2 Getting Started with the Clay Tablet Connector for Sitecore 2.2 The Connector at a Glance

Sitecore Content Editor

B You can use the CTC Translation tab in the Sitecore Content Editor to perform multiple translation-
management tasks and to view a summary of the translation status of all the content items in your Sitecore
instance:

HOME NAVIGATE REVIEW ANALYZE PUBLISH VERSIONS CONFIGURE PRESENTATION SECURITY VIEW CTC TRANSLATION
Backuy
H ‘&l Bulk Translation J] Translation Queue  jgf Clear backup data Fincoirud Sarimens
g g s 0 Comg Archied
Sending T In Tranglaten: 0 Jobs (Archived) 39 CTT Lag Files

Save J Translation Filter |l Translation Status «| Item Translation Details

B You can use the Translate button in the Review tab in the Sitecore Content Editor to send out a single item
for translation:

SECURITY VIEW CTC TRANSLATION MY TOOLBAR

(%)
© 8

D Reject Reminder =  Archive =

ANALYZE PUBLISH VERSIONS CONFIGURE PRESENTATION

@

My items

HOME

H K4

Save Spelling

NAVIGATE

Click Edit to lock and edit this item. =¢ Edit

(3

Validation

@

Markup

et

Subscribe = SEO Analysis & History

B You can use the WorkflowCT3Configtemplate to build your own translation workflow:

HOME NAVIGATE REVIEW ANALYZE PUBLISH VERSIONS CONFIGURE PRESENTATION SECURITY VIEW CTC TRANSLATION MY TOOLBAR

Builder
OFTIONS
H ] Template section 1012) » j‘j [ Copy to x &5 Rename A Up £ First
-
Save [ Insert from template 20f2) w Duplicate»  [& Moveto  Deletew [ Display name w Down ¥ Last
h Builder Inherntance Content Q
4 @ sitecore Unversioned Shared
» & Content
» B Layout CT3Translation
b & Media Library
b @ socia
Field TypesNaadTransiation TreelistEx v datasource=isitacorasystem/Fiald typesidatabasename Ed
b @9 Sycstem
a [E Templates
b i@ App Center Sync Transiate from Draplink v fsilecora/systemianguages &
» & Branches
4 1] clayTable3 . .
Translate to Checklist v fsitecore/systemianguages o+
» [l ciay Tablet Settings
L e e .
[NE T Media Library  Workbox
B Youcan usetheCT3 Sample Workflow workflow to configure your translation workflow:
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2 Getting Started with the Clay Tablet Connector for Sitecore 2.2 The Connector at a Glance

NAVIGATE REVIEW ANALYZE PUBLISH VERSIONS CONFIGURE PRESENTATION SECURITY VIEW CTC TRANSLATION MY TOOLBAR

- < [ Insert from template ~ (10f1) & ) [ Copy to ® = Rename A Up # First
-
Save Editw ¥ Duplicate » % Move to Delete = |7] Display name w Down ¥ Last
S m Q g~ | [ engione | [ 1
o o . P
» [ setings Initial state [shared]
@ soca Workflows/CT3 Sample Workflow/Editing -
» & Tasks
» @ Toolbox Detault Comment Template
4 B Workflows
Templales/SystemMorkfiow/Standard Commant Template -

b ' Analytics Testing Wo

» Analytics Workflow 3 -

- i ! Default Comment Dialog Height
» % CT3 Sample Workflo

250

» B LandingPageWorki
¥ '® Path Analyzer Maps
b Regular Review CT3Translation A
» % Sample Worklow
» " Experience Analytice Field Types to be Sent For Translation [shared
» ' Social Account Rene Edit

» [ Multi-Line Text -

Sitecore Page Editor (Sitecore 6 and 7)

You can use the Translate To button on the CTC Translation tab in the Sitecore Page Editor to send a single
content item for translation:

H # Home  Advenced  Experience  Testing  Properties  View  CTC Translation

Preview - Translate Ta

Made Translation

Sitecore Experience Editor (Sitecore 8)

You can use the Translate To button on the CTC Translation tab in the Sitecore Experience Editor to send a
single content item for translation:

HOME PRESENTATION EXPERIENCE NS OPTIMIZATION VIEW CTC TRANSLATION l

Eait Other Transiate To

Sitecore Desktop (Sitecore 6 and 7)

You can use the menu items in the CTC Translation folder on the Sitecore menu.
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& | Bulk Translation

Manage your conts
_* Carousel ﬂ Display name Translation
i 4| Marketing Cent )
J_:_) Confioure marketi| @ Content Editor | Transtation Fiter

features, @) control Panel 2] | Translation Queus
= Media Library ﬂ Translation Status
Masintsin eor i Developer Center

) E-mai Campaign , Chear backup data

ﬂ Engagunall:.tn-m File Explorer

Tnsight and Optimll o e Bitor
Executive Dashl L2 Jetstream Contral Panel
Exeastive Insight | 2y 5 iream Dema Control Center

Security Editor | 8 Kevboard Map
Grant and revoke
FJ Log Viewer

permissnns
“ Template | Media Library
Create new ufl Recyde Bin

£ Sl'bemrelppteﬁnm
& Instal and maintad w5 Search

-

Servirity r
Publish Site
Publish your Sitecore on the Met k
System k
Al Applications ﬂ Template Manager

T Workbox
B Classy 5C Manager
[E] web Forms for Marketers b

2.3 Working with Lists

The Connector has many list pages, often for displaying lists of content items.

Tips: For lists where you can select multiple items, press the Shift key to select a range of adjacent items.
Press the Ctr1 key to select multiple non-adjacent items.

You can perform the following actions in list pages:

F Alist with many items may have multiple pages. You can navigate among pages in a list. For details, see
"Navigating Pages in a List" on page 16.

¥ You can set the width of a column in the list. For details, see "Setting Column Width" on page 17.
¥ You can change the column order. For details, see "Changing Column Order" on page 18.

P You can sort the items in the list by a specific column. For details, see "Sorting by Column" on page 17.

Clay Tablet Connector for Sitecore User Guide Page 15
Version 3.10.0 June 14, 2017



2 Getting Started with the Clay Tablet Connector for Sitecore 2.3 Working with Lists

¥ You can search for an item in the Translation Status window. For details, see "Monitoring Status for Multiple
Items" on page 71.

¥ You can specify the number of items to display in a single page in the Translation Status window. For details,
see "Monitoring Status for Multiple ltems" on page 71.

¥ You can group theitems in the list by one of the columns in the Translation Status window. For details, see
"Grouping Content Items by Column" on page 19.

2.3.1 Navigating Pages in a List

If there are many items in a list, the list may have multiple pages. The navigation bar below the list helps you
navigate through the pages and displays your position in the list.

For example, the Add an Account dialog box may have multiple pages in its list.

Add an Account

nftype and then click the relevant

sitecorslAnalytics Advanced Tasting
sitecore\Analytics Content Profiling
sitecore\Analytics Maintaining
sitecore\Anahtics Management Reporing
sitecare\Analyflics Personalization
sitecorslAnalytics Reponing
sitecore\Analytics Testing

sitecorelAuthor

sitecare\Designer

sitecare\Developer

sitecors\Expenance Explorar
sitecore\Facebook Message Reviewer
sitecoreiList Manager Editors
sitecore\Sitecore Client Account Managing

sitecare\Silecore Client Advanced Publishing

(Iq 4 ¥ M | Page1of3(39items)
W

You use the arrow keys at the bottom of a list to navigate through multiple pages in a list.
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2.3 Working with Lists

Arrow Key

What It Does

Opens the first page.

Opens the previous page.

Opens the next page.

El| ) ] 6

Opens the last page.

The bottom right corner of the windows displays the current page in the list, the total number of pages in the
list, and the total number of items in the list. The maximum number of items displayed in a list page depends on

the particular list.

2.3.2 Setting Column Width

You can set the width of any column in a list.

1. Mouse-over theright border of the column.

The cursor is displayed as a white line with arrows at each end.

Lanpﬂge@yr

es-E5
nfu-.I:,"I
zh-CH 3
de-DE 1
da

[

Type

w Translabon
w Translabon

w Translabon

Mew Translabon

Mew Translabon

2. Dragthe column border to its new position.

Dragging the column border to the left makes the column narrower.

¢ Dragging the column border to the right makes the column wider.

2.3.3 Sorting by Column

By default, items in a list are displayed by alphabetical order of the item in the first column of the list.

You can sort items in a list by any column. For example, suppose that in the Translation Status window, you
want to display all content items by language.

F Click the column heading.

For example, click the Language column heading.
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2 Getting Started with the Clay Tablet Connector for Sitecore 2.3 Working with Lists

Lan e Version Type

[ -:5% 2 Meve Translation
fr-FR 2 Meve Translation
TN 3 Heve Translabon
dia-0E 1 Hew Translabon
da 1 Mew Translabon

The first time you click in the column heading, the column contents are sorted in ascending order. The arrow
in the column heading indicates the sort order.

Langn.laqo- Version  Type

da i Mew Translation
de-DE 1 esw Translation
es-E£5 2 et Translation
frFR 2 e Translation
zh-CH 3 New Translation

F If you want to reverse the sort order, click again in the column heading.

Languagd(") verson  Type

h-CM 3 New Translation
frFR 2 hew Translation
es-E5 2 Mew Translation
de-DE 1 MNew Translation
da 1 Mew Translation

2.3.4 Changing Column Order

You can change the order in which columns in lists are displayed. For example, suppose you want to move the
Language column to the right of the Version column.

1. Click the column heading to move.

For example, click the Language column heading.

Lan e Version Type
[ -:5% Meve Translation

[ ]

fr-FR. Heww Translabon
#hCN 3 Mews Translabon
dia-DiE 1 Mew Translabon
da 1 Mew Translabon

2. While you hold down the cursor, drag the column heading to the new position. (A copy of the column
heading "floats" above the table.) Red arrows indicate the new position of the column.
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Miew Translation
New Tranglation

Iewi Translation

2
2
3 Mewi Translation
1
1

Mewi Translation

3. Release the cursor when the column is in its new position.

Version  Language Tyoe

2 es-ES Mesw Translation
2 fr-FR e Translation
3 zh-CM Mesw Transiation
1 deDE Mew Translation
1 da Mew Translation

2.4 Grouping Content Items by Column

In the Translation Status window and the Translation Queue, you can group the items by one of the columns.
The example below shows how to group the content items in the Translation Status window by the Language
column.

1. Click the column heading. For example, click the Language column heading.

Translation Status

Open Selected ltems Update Remote T Archive Job Refresh

Drag a column to this area to group by it Search:

feontentHomeProdudsfacation-Products/Swim-Fins ja-JP 3 Mew Translation 44b2bd2a-79fF-47 3B-ae67-bB5MBbd2di41 In Translation [
IcontentHomeProdudsivacation-FProducts ja-IP 3 Mew Translation 44bZbdZ2a-ToM-47d8-ae67-bESMEbA2 41 In Translation [E§
IcontentHome/ProductsOffica-Products/Desk-Lamps ja-JP 3 Mew Translation  44b2bd2a-ToM-4738-aab7-DESMEDA2dI41 In Transiation [
lcontentHome/ProductsiOffice-Products/Desk-Lamps he-IL 1 New Translation = 1edf345a-ece8-4adc-a189-1d0d05948893 | In Translation | [E
fcontentHome/Producs/Ofice-Products/Desk-Lamps/Black-Goose 1a-JP 3 Mew Translation | 44b2pd2a-7of-47¢8-ae67-085f8bA2dM41 | In Translation  [E
fcontentHome/Products/Office-Products/Desk-Chairs/The-Standard ja-JP 3 Mew Translation  44b2bd2a-70f-47d6-3e67-bB5f3bd2df41 | InTranslation [
IcontentHomeProducs™Home-ProdudsiWash-o-malic ja-1P 3 Mew Translation 44bZ2bdZ2a-TOM-47d5-ae67-bESMEbA2 41 In Translation [E§
IcontentHomea/ProductsOffica-Products/Desk-LampsiThe-Silver-Star he-L 1 Mew Transiation  1edf345a-eced-4adc-a189-1a0405348593 | In Transiation [
IcontentHome/ProductsMvacation-Products/Swim-Fins he-IL 1 MNew Translation = 1edf345a-eced-4adc-a189-1d0d05948893 | In Translation | [E
IcontentHome/Products/Office-Products ja-JP 3 Mew Translation 44b2bd2a-T9f-47d6-aeb7-085Mbd2di41 | In Translation [
IcontentHome/ProductsHome-ProdudsiCool-o-matic ja-JP 3 Mew Translation  44b2bd2a-7O-4738-aeb7-bESfabA2 41 In Translation [
IcontentHome/ProductsHome-ProductsiWash-o-matic he-IL 1 Mew Translztion 1edf345a-eces-4adc-a189-140d05348393 | In Translation [I§
IcontentHome/Products/™Mome-Produdts he-IL 1 Mew Translation = 1edf345a-eces-4ade-a188-1a0d05948893 | In Translation [
[contentHome/Products ja-JP 3 MNew Translation | 44b2bd2a-75f-47d8-ae67-bB5MBbd2di41 | In Translation [
IcontentHome/Products/Office-ProductsDesk-LampsiGoosy-Swing-Arm  ja-JP 3 Mew Translation = 44b2bd2a-T9f-47dE-aef7-085f8bd2di41 | In Translation [

v
p— o - - - R O | PR P . .
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2. While you hold down the cursor, drag the column heading to the Drag a column to this area to group by it
area above the list on the left.

This list items are grouped by the column you dragged.

Translation Status

= Job cie languages il Page sive - -
[V . ~ 2 ) . «s,
Open Selected tems o Update Remote TM  Archive Job —£- Refresh
[Group by.Language Search:
L 1age; jz-JP
»
| J
P Lan 1age; he-ll
Pia 1age; ja-JP
v - 3 i Page 1 of 2 (30 items)

Job:  pmducts in multile languages - Fage size e *]
B —5 v & & ; <
Open Selectad ltems ' s Update Remote TM  Archive Job —a- = Refresh
iGroup byLanguage Search:
4 | anguage ja-JP
IcontentHome/ProducisVacation-Products/Swim-Fins ja-JP 3 New Transiation 44b2bd23-70f-47d8-ae67-b85fB0A2df41  InTransiation [
IeantentHomeProdudsifacation-Products ja-JrP 3 Mew Translation 44b2bd23-7OM-47d8-2267-bBSMEbA2d41 Ini Translation [
IcontentHomeProducts/Office-ProductsDesk-Lamps ja-JP 3 New Translation 44b2bd2a-7o0-47d3-ae67-bB5MBbA2dI41 In Translation [
4 | anguage: he-IL
fcontentHome/Products/Office-Products/Desk-Lamps he-IL 1 MNew Translation 1edf3453-eceB-4adc-a189-100d05948893 In Translation [
4 | anguage ja-J
IcontentHomeProduds/Office-ProductsDesk-Lamps/Black-Goose  ja-JP 3 Mew Translation 44b2bd23-79f-47d8-3e67-b85MBbd2d41  In Translation [ER
IcontentHomeProduds/Ofice-Products/Desk-Chairs/The-Standard  ja-JP 3 Mew Translation 44b2bd23-70f-47d8-2e67-bBSMELA2d41 In Transiation | [E§
IcantentHomeaProdudtsHome-ProdudsiWash-o-matic a-dP 3 New Translation 44b2bd2a-7ON-47d8-ae67-bB5BbA2A41 In Translation {5
4 | anguage: he-IL
IcontentHome/Produdts/Offica-Products/Desk-LampsiThe-Siver-Star  he-IL 1 Hew Translation 1edf345a-ace8-4adc-a189-100d05948893  In Transiation [
leamtentHome/ProductsVacation-Products/Swim-Fins he-IL 1 Mew Translation 1edf3453-eceb-4adc-a189-1d0d05946893 In Translation OER
LY guage: ja-JP
W
< > w
F detailed d ipti ftheT lation Stat ind "Monitoring Status for Multiple It "
Oor a aetalle escription o e lransiation >tatus window, see oniltoring Status tor Viultiple Items” on
page 71.
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3

Creating Content for Translation

B |fyou are sending a single content item for translation, it must have a translation workflow assigned.

# There are three ways to do this when you create a content item:

= Assign it to the sitecore/System/Templates/ClayTablet3/WorkflowCT3Configtemplate.
This template uses the translation workflow, which is contained in the
sitecore/System/Workflows/CT3 Sample Workflow.

- Assign it to your own template. Ensure that your template uses the translation workflow, which is
contained in the sitecore/System/Workflows/CT3 Sample Workflow.

: Assign it to your own template, which uses your own workflow. Ensure that the base template of your
workflowis /sitecore/templates/System/Workflow/TranslationWorkflow. For detailed
instructions, refer to the Clay Tablet Connector for Sitecore Installation and Configuration Guide.

If a content item was already created, but a translation workflow was not assigned to it, you must assign a
translation workflow to that item. For details, see page 26.

If you are sending multiple content items together using the Bulk Translation feature, you do not need to
assign a translation workflow to individual content items. You can assign a translation workflow and assign a
workflow state to all items without an assigned workflow. For details, see "Sending Multiple Content Items
for Translation" on page 46.

3.1 Attaching a New Content Item to a Translation Workflow

To create an item that you can send for translation individually, you must either use a template that has the
Clay Tablet workflow attached, or use a template that is attached to your custom translation workflow.

Note: If you will be sending an item for translation using the Bulk Translation feature, described in "Sending
Multiple Content Items for Translation" on page 46, you do not need to assign a template with a translation
workflow to the item.

1.

In the Sitecore Content Editor, under Content in the navigation pane, locate the place in the tree where you
want to create a new item that will be sent for translation. Next, right-click and select Insert > Insert from

Template in the context menu.

The Insert from Template dialog box opens.

Select one of the following templates:

# The template attached to the default Connector workflow,
Templates/ClayTablet3/WorkflowCT3Config

# The template attached to your custom translation workflow, if you have created one.

Click Insert.
The item opens, displaying the Content tab.
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4. Enter the content to translate in the Data section.

5. In the CT3Translation section, specify the following workflow options:

Parameter Description Default Value

Field Types to be Sent Determines which types of fields the Connector can send | By default, the

For Translation out for translation when it sends an item for translation. Connector sends out
This is relevant for all templates. If you create a custom fields of the following
field type, you must add it to this list so that you can field types for
send it out for translation. translation:

Note: You cannot set Shared Fieldsto besentoutfor | ® text
translation, because these fields are shared across all B Rich Text
versions and languages of an item. " html

To change these fields, click the Edit button above the -

list. In the dialog box that opens, select the field types to -

add, and use the blue arrow g} to copy them to the
Selected column. When you are done, click OK.

Tip: You can use the Shi ft key to select multiple
adjacent field types.

Single-Line Text
Multi-Line Text

Translate From (Source The source language from which to translate the items. Usually this is the

Language) Select a language from the list. Sitecore default
language.

Translate To (Target The target languages that are available for translating the | n/a

Language) items attached to the workflow. To translate into specific

target languages, select the corresponding check boxes.

Clay Tablet Connector for Sitecore User Guide Page 22
Version 3.10.0 June 14, 2017
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Parameter Description Default Value
Synchronize Translation | Determines whether the Use Local TM feature is check box is cleared
(detect changed content | available when translating items attached to this

and resend) workflow. This feature checks each field of the source

version for any content changes, and it sends only

changed content fields out for translation, to ensure that

all target versions reflect these changes.

B When this check box is selected, you can activate this
feature by selecting a check box in either the Bulk
Translation wizard or the Automatic Item Export for
Translation dialog box. The Use Local TMfeature may
reduce translation costs, but it needs the Connector
translation backup data, and it increases the
Connector processing time before the Connector
sends out the items for translation.

B When this check box is cleared, you cannot activate
this feature, because the related user interface is not
displayed. The Connector sends all specified source
content for translation, even if it has not changed
since it was previously sent for translation.

Requested Translation Determines the translation deadline when sending out 15
Timeframe (Days) the translation automatically, without using the user
interface that supports entering this information in the
Delivery Date field. This information is sent to the
translation provider as metadata of the translation
package. If you set this parameter to 14, the deadline will
be two calendar weeks after you submit an item for
translation.

Recommendation: Discuss whether to use this feature
with your translation provider(s).

Workflow State to set The workflow state to set when a source item has been /sitecore/system/

when Sending Content selected for translation. Workflows/CT3

for Translation Sample Workflow/
Sending for
Translation
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3.1 Attaching a New Content Item to a Translation Workflow

Parameter

Description

Default Value

Workflow State to set
(for Source Content)
once content has been
sent for translation

The workflow state to set for a source item after the
Connector has sent it out for translation. For example, in
some companies, when you send out the content for
translation, the source is ready for publishing. In this
scenario, you can set this state to Done, which is a
publishable state. Alternatively, if your company has a
final review process, you can set this to another state
that is not publishable.

By default, this state
is not set, so the
source item's state
does not change
when you send it out
for translation.

Workflow State to set
for Content while it is
out for translation

The workflow state to set for target content when an
item is being translated. The default In Translation
workflow state enables you to see which items are still
out for translation. It facilitates following up with your
translator about items that you have sent out for
translation, but that you have not yet received back.

/sitecore/system/
Workflows/CT3
Sample Workflow/In
Translation

Workflow State to set
when a translation
process has been
cancelled

The workflow state to set when an item’s translation
request has been cancelled.

A user can cancel translation from the Translation Queue.
Atranslation request is automatically cancelled if a fatal
error occurs while sending out an item for translation,
such as an incorrect language code, or insufficient user
permissions.

/sitecore/system/
Workflows/CT3
Sample Workflow/
Reviewing

Workflow State to set
when content
Translation is complete

The workflow state to set when an item translation has
been completed, and it is back in Sitecore for review and
publishing.

/sitecore/system/
Workflows/CT3
Sample Workflow/
Editing Translated
Version
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3 Creating Content for Translation 3.1 Attaching a New Content Item to a Translation Workflow

Parameter Description Default Value
Send Content Enables sending all items to the Translation Queue check box s cleared
automatically using pre- | without further user action. That is, the Connector

configured language automatically uses the Translate from, Translate to and

settings Requested Translation Timeframe information, defined

above, to immediately send content to the Translation

Queue without enabling the user to change these

parameters: the Language Selection pop-up window does

not open.

B |fthis check box s selected, the Language Selection
pop-up window does not open when you send
content to the Translation Queue: you cannot select
the target languages or the destination, but sending
items for translation is streamlined.

B |fthis check box s cleared, the Language Selection
pop-up window opens when you send content out for
translation: you can select the target languages, so the
process is less streamlined. However, this provides
greater control for the user.

Automatically Publish Determines whether the Connector automatically check box is selected
content when it reaches | publishes the content when an item reaches the final
the Final State state of the translation workflow.

B [fthis check box is selected, the Connector
automatically publishes the content when an item
reaches the final state.

m [fthis check box s cleared, the Connector does not
automatically publish the content when an item
reaches the final state.

Publish to which The target databases for publishing content if the n/a
Database? Connector needs to publish an item.
Publish child items? Determines whether the Connector publishes child items | check box is selected

when it publishes their parent item.

B |fthis check box s selected, the Connector publishes
child items when it publishes their parent item.

B [fthis check box s cleared, the Connector does not
publish child items when it publishes their parent
item.
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3.2 Attaching a Translation Workflow to an Existing Content Item

If you have a content item that is attached to a template that does not include a translation workflow, you can
still prepare to send it out for translation individually. To do so, you assign a translation workflow to the content
item.

Note: You can assign a translation workflow to a content item only if you can assign a workflow to that content
item. This means that the content item must inherit the workflow data item from its data template. For more
information, refer to the Sitecore Data Definition Reference. This guide is available in the documentation section
of the Sitecore Developer Network (SDN) site, at http://sdn.sitecore.net/Reference.aspx. You must log in to this
site to access the documentation.

To attach a translation workflow to an existing content item:

1. Inthe Sitecore Content Editor, navigate to the content item to which you want to attach a translation
workflow and select it.

2. Inthe Sitecore Content Editor ribbon, click the Review tab.

3. In the Workflow section, click Edit.

Tip: If the Workflow section is not visible, then in the Sitecore Content Editor ribbon, click the View tab and
select the Standard Fields check box.

4. In the Content tab, scroll down to the Workflow section.

5. If necessary, click the Expand button [# to expand the Workflow section.

Workflow

Slale

Lock

T

<r pwner="sitecore\admin” date="201T70425T1T20452" />

Default workflow

6. Inthe Workflow field, click the arrow to select CT3 Sample Workflow oranother translation workflow.

7. Optional. In the State field, click the arrow to select the workflow state.
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3 Creating Content for Translation 3.3 Filtering Fields in Items that Do Not Need Translation

8. In the Review tab on the Sitecore Content Editor ribbon, in the Workflow section, click Check In.

3.3 Filtering Fields in Items that Do Not Need Translation

You can use the Translation Filter window to filter out fields that never need translation. You can access this
feature from either the Sitecore Content Editor or the Sitecore Desktop (Sitecore 6 and 7 only).

You initially specify which types of fields the Connector sends for translation using the Field Types to be Sent
For Translation workflow-level parameter.For details, see "Attaching a New Content Item to a Translation
Workflow" on page 21.

You use the Translation Filter feature to further exclude certain types of fields from content that the Connector
sends for translation, per the template. You can create filters when initially configuring the Connector, or you
can create or update the filters at any time.

When a user sends out an item for translation, the Connector collects the content from all fields in the item with
the field types specified in that parameter, in preparation for sending them out for translation. Then, if there are
some fields that you do not want to send for translation, even though they belong to field types that the
Connector sends out for translation, you can use the Translation Filter to exclude them.

1. Do one of the following to open the Translation Filter window:

In the Sitecore Content Editor ribbon, click the CTC Translation tab, and then in the Translation Tools
section, click Translation Filter.

MNAVIGATE REVIEW ANALYZE PUBLISH VERSIONS CONFIGURE PRESENTATION SECURITY VIEW CTC TRANSLATION MY TOOLBAR

(¢l Bulk Translation & Translation Queue i Clear backup data

Save [8 Transiation Status

~ Item Translation Details

In the Sitecore Desktop, click the Sitecore menu, and then select All Applications > CTC Translation >
Translation Filter from the menu. (Sitecore 6 and 7 only)

The Translation Filter window opens.
If you use the Sitecore Content Editor in Sitecore 6 or 7, it opens in a separate browser window.

If you use the Sitecore Content Editor in Sitecore 8 or the Sitecore Desktop, it opens in the same browser
window.
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Translation Filter O X
uf ¥ i W R
Dialeta Al Filters Delete the selaciad Filters Add Filter selected field for ALL Refrash
Dirag a column to this area to group by it Search:
[All Templates] MenuTitle [ALL] false
ftemplates/etstream/Content'Cabin Profile Landing Page Title Single-Line Text frue
- 2 " B Page 1 of 1 (2 items)

=
2. Click the Add button to add a new filter.

The Welcome page of the Field Filter wizard opens.

3. Click Next.

The Choose a Content Template page of the Field Filter wizard opens.

Choose a content template Ll X

Please choose the Content Template with the fields you want filered and therefore not sent for
franslabon.

Choose a Content Template

4 5| Teamplabes

k@ App Center Sync

b & Branches
¢ ) ClayTabletd
¢ {1 Comman

k4 Emall Campaign
b Jetsiream
L ListManager

¥ i Sample -

Back m Cancel

4. Select the content template to associate with the fields you want to filter, and exclude from translation. Use
the Expand [# and Collapse = icons to navigate the tree. Click Next.

The Select Fields that you don't want sent out for translation page of the Field Filter wizard opens.
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Select Fields that you don't want sent out for translation 4

Select Fields that should not be sent for ranslafion. Note: Shared Fields are never sent out for
translation. They are visible for reference only

@ & MenuTitle Single-Line Taxt Cabin Detall Page

= Meta Description Multi-Ling Text {shared Cabin Detail Page

=] Side Menu Checkbonx (shared Cabin Detail Page

Summary Rich Text Cabin Detail Page

& Body Rich Taxt Cabin Detall Page
Back Mexi = Cancel

This page displays the following information about all the fields in the template you selected:

Column Description

Field The name of a field type in the template.
Type The description of the field type.

Shared Indicates whether the field type is shared.
Template The template where the field type is located.

5. Select the check boxes of the field types you want to exclude from translation, and click Next.

Note: Shared fields are never sent for translation, so they are automatically excluded from translation. You
do not need to select them.

The Don't transfer field value page of the Field Filter wizard opens.
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Don't transfer field value O X

Select the fillered fields whose Seld data be should also NOT be copled to the target version

Don't ransfer field value

(] MenuTitle Single-Line Text Cabin Detail Page

This page displays only the field types you selected in the previous page of the wizard.

6. For each field type, indicate whether you want the Connector to copy the source-language content to the

target version.

If you do not want the Connector to copy the source-language content of a field type to the target
version, select the corresponding check box. This field type will be excluded from the target content.

If you want the Connector to copy the source-language content of a field type to the target version, clear
the corresponding check box. This field type will be included in the target content; however, the content

will be in the source language.

Click Next.

The summary page of the wizard opens.
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The CTC Filter wizard is complete. Click Finish to clne
the wizard.

Thi selected Fialds have baen added to the Translation Filter:

Template

Cabin Detail Page MenuTitle Single-Line Text

Clasa

This page displays the following information about the fields to exclude in the new filter.

Column Description

Template The name of the template where the field type to exclude from translation is located.
Field The name of the field type to exclude from translation.

Type The type of field to exclude from translation.

Don't transfer | Indicates whether the Connector copies the source-language content to the target

field value version for this field type.

B Blank indicates that the Connector does copy the source-language content of a field
to the target version, select the corresponding check box. This field will be included in
the target content; however, it will be in the source language.

B yes indicates that the Connector does not copy the source-language content of a
field type to the target version. The Connector does not automatically transfer the
value of the field in the source version to the field in the target version.

7. Click Finish.

8. Sitecore 8 only. A message box opens, confirming that you want to close the wizard. Click OK.

The wizard closes, and the Translation Filter window displays each filter you created in a separate row:
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Translation Filter O X
- - ] = oﬂl\,
o o 03 3 <
Delete All Filters ~ Delete the selected Filters Add Fitter selected field for ALL Refresh

Drag a column fo this area to group by it Search:

[All Templates] MenuTitla [ALL] falze

Memplates/letstream/Content'Cabin Profile Landing Page Title Single-Line Text frue

T 4 - i Page 1 af1 (2 items)

This window displays the following information about the filters:

Column Description

Template | The path and name of the template. Field types in this template can be excluded from

Path translations.

Field When the Connector sends out content items based the specified template for translation, it
Name does not send out this field's content for translation.

Field The type of this field to exclude from translation. When [ALL] is displayed, then all types of
Type this field are excluded from translation.

Don't Indicates whether the Connector copies the source-language content to the target version for
transfer this field type.

field B falseindicates that the Connector does copy the source-language content of a field type
value to the target version, select the corresponding check box. This field will be included in the

target content, however it will be in the source language.

B trueindicates that the Connector does not copy the source-language content of a field to
the target version. The Connector does not automatically transfer the value of the field in
the source version to the field in the target version.

Now that you have created a filter, you can perform the following actions in the CTC Translation Filter
window (in addition to the Add Filter button, which was described above in step 3):

Button Description

Deletes all filters displayed in the CTC Translation Filter window.

&l

n

Delete All Filters

<
I
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Button Description

_— Deletes all selected filters from the CTC Translation Filter window.

]

Delete the selected Filters

hd\}J Applies the selected filter to all templates with the same field type.

Filter selected field for ALL

| Refreshes the list of displayed filters.
L
Refresh
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4 Sending Content to Translation

If you send a single content item for translation, it must be in a workflow state that enables it to be sent for
translation. This corresponds to the Reviewing workflow state that is part of the default CT3
SampleWorkflow translation workflow. If you send multiple content items for translation using the Bulk
Translation feature, you can assign a workflow and workflow state to the items at that time.

When the Connector sends out content items for translation, the following events occur:
1. The Connector exports the content from the Sitecore CMS as HTML or XML files. The format is determined

by the ClayTablet.PackedFileFormat settingin the CT3Translation.config file. For details, refer
to the Clay Tablet Connector for Sitecore Installation and Configuration Guide.

2. The Connector creates placeholders for the content of the language versions of the specified target
languages.

3. The Connector delivers the export files to the Clay Tablet Platform, along with information about the target
languages, and source location within Sitecore. The Clay Tablet Platform then delivers these files to the
translation provider(s) specified in your company's routing rules.

Note: Using the translation workflow for a content item does not obligate you to send out that content item for
translation. You can move the content item through the entire workflow without sending it out for translation.

4.1 Workflow States

The sitecore/System/Workflows/CT3 SampleWorkflow workflow contains all required states for the
Connector translation management process.

By default, it has the following seven states, which are listed, in order, below.

Workflow State Relevant for Source Content | Relevant for Target Content
Editing v
Reviewing v
Sending for Translation v
In Translation v
Editing Translated Version v
Reviewing Translated Version v
Done 4 v
Note: Only content in the Done state is publishable.
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4.2 Submitting a Content Item for Translation using the Content Editor

This section describes how to submit a content item for translation using the Sitecore Content Editor. It is
relevant only for a single content item that uses a template that has a translation workflow attached, as
described in "Creating Content for Translation" on page 21. For instructions on submitting multiple content
items for translation, see "Sending Multiple Content Items for Translation" on page 46. For instructions on
submitting a single content item for translation using the Sitecore Page Editor, see page 41.

Depending on your company's Connector configuration, when you submit the item for translation, either:
B The Connector immediately sends out the item for translation.

B The Connector sends the item to the Translation Queue, which is a holding area for items that are ready for
translation.

To submit a content item for translation:

1. Inthe Sitecore Content Editor, navigate to the content item that is ready to sent for translation and select
it.

2. Inthe Sitecore Content Editor ribbon, click the Review tab.

3. In the Workflow section, click Submit.
Note: The Submit button is displayed only if the content item's workflow state is Editing.

A dialog box opens.

Enter a comment

Commenis

4. Optional. Add a comment to this action. The Connector does not use this comment, but it is available in

Sitecore.
The content item moves to the next state in the workflow, which is Reviewing.

The Workflow section of the Review tab is updated to display the Publish, Reject, and Translate buttons.

Note: These buttons are displayed only if the content item is in the Reviewing workflow state.
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HOME NAVIGATE REVIEW ANALYZE PUBLISH VERSIONS CONFIGURE PRESENTATION SECURITY VIEW CTC TRANSLATION MY TOOLBAR

ags | ! R R Click Editto lock and editthis ltlem. < Edit = Publish & =
Spelling Markup Validation Subscribe = SEO Analysis

My items

S History D Reject Reminder =  Archive =

Note: Using the translation workflow for a content item does not obligate you to send out that content item

for translation. You can move the content item through the entire workflow without sending it out for
translation.

5. Click Translate.

Optional. Depending on your company's Sitecore configuration, an additional comment box may be
displayed. If so, you can enter a comment and click OK.

The next step depends on your company's Connector configuration. Usually, the Automatic Item Export for
Translation dialog box opens.
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Automatic ltem export for translation

Send Sitecore items for translation, automatically

Translate /sitecore/content'Home [ en Vi1 ]
DSEn::I dependent items (0}

Te Language

[] select Al

|:| Japanese (Japan): BFZE HE)

|:| Hebrew (lsrael) : frower) oy

Translation Option
|:| Use Local TM {Only send out changed content for translation).

SEC Fields

[] 5=nd Seo fields
Send Standard fields

S5end To Options
D Send items to translation queue
@ Send items to translation provider

Job Name
Delivery Date 8270
PO Reference

Desoiption
Send for Quote |:|

I:::l Copy source to target only

Ok Cancel

The following options may be available, depending on your company's Connector configuration:

Option Description

Send Select this check box to include items from the layout and final layout that are dependent

Dependent | on the selected content item. This is useful, for example, if a page item has multiple layers

Items with different data sources, and you want to translate all the items displayed in the page.
The number in parentheses indicates the number of dependent items.
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Option Description

To Select the check boxes for the target languages into which you want to translate the
Language content. If you want to translate the content into all available target languages, select the
Select All check box.

Tip: When you select a target language, if an error states that the language code is
misconfigured, it means that you do not have read access to that language. You require
read access to a language to send out content for translation to that language.

Note: Depending on your company's Connector configuration, some languages may already
be selected. If so, you can clear any selected languages that you do not want to include.

Use Local Determines whether to check each field of the source version for any content changes, and
™ send only changed content fields out for translation. If a field was previously translated and
it has not changed, then the Connector does not send it for translation again: Instead, it
uses the stored translation.
When this check box is selected, the Connector sends only changed content fields out for
translation. This may reduce translation costs, but it increases the processing time before
the Connector sends out the items for translation.
When this check box is cleared, the Connector sends all specified source content for
translation, even if it has not changed since it was previously sent for translation.

Note: If the Use Local TM feature is enabled, the Connector checks each field of the source
version for any content changes, and it sends only changed content fields out for
translation, to ensure that all target versions reflect these changes. This option may also not
be available based your company's Connector configuration. For details, refer to the
description of the Use Local TM setting in the Clay Tablet Connector for Sitecore
Installation and Configuration Guide.

SEO Fields | Select the check boxes for the types of content to send out for translation.
Send SEO fields: The Connector sends fields defined in the SEO Fields section of the Clay
Tablet Settings items for translation. Cleared by default.
Send standard fields: The Connector sends the fields specified by the Field Types to be
Sent For Translation parameter in the CT3 Sample Workflow. Selected by default.
For more information, refer to the Clay Tablet Connector for Sitecore Installation and
Configuration Guide.

Select one of the following Send To Options:

Send items | The Connector sends the content item to the Translation Queue, where a user must

to approve it to send it out for translation.
translation
queue
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Option

Description

Send items
to
translation
provider

The Connector sends the content item to the Clay Tablet Platform, which sends it to the
translation provider specified in the company's routing rules. The Connector displays
additional fields below, where you can specify additional information.
Recommendation: Select this option if you need to quickly send out content and do not
need to arrange or filter it, for example, by language.
Send To: If your company has multiple translation providers, and if your company's
Connector configuration enables selecting the translation provider (instead of using
automatic routing rules), you can select the provider for this item in the dropdown list.
Job Name: Your name for this translation job.
Delivery Date: The requested translation deadline. This is the date when you expect the
translated content to return. By default, it is two weeks from the current date. To select a
different date, either type the delivery date in the field in MM/DD/YYYY format, or click
the arrow and select a different date in the calendar that opens. This information is sent
to the translation provider as metadata of the translation package.
Note: The default displayed date is based on your company's Connector configuration.
Recommendation: Discuss with your translation provider whether to use the
information in this field.
PO Reference: The purchase order reference number.
Special Instruction: Any additional instructions for Lionbridge Freeway. Displayed only if
Lionbridge Freeway is selected in the Send to box, above.
Analysis Code: The analysis codes for the translation. Displayed only if Lionbridge
Freeway is selected in the Send to box, above. You specify the analysis codes that are
relevant to your content.

Your Lionbridge setup determines which analysis codes are available for you to specify,
and the values available for selection for each analysis code. In this example, the Region,
Department, and Priority analysis codes are available for you to specify.

Description: A description of the translation job, including any special instructions or
requests. Displayed only if a translation provider other than Freeway is selected in the
Send to box, above.

Send for Quote: Select this check box to inform the translation provider that you want to
receive a quote before the translation process starts. Displayed only if supported for the
selected translation provider and enabled in your Connector installation.

Copy
source to

target only

The Connector copies the source content to the target content item without sending it out
for translation. This is useful when there is content that you do not want to translate, but
that you want to include in the target version. The Connector displays an additional field
below, where you specify the job name.

Job Name: Your name for this job.

7. Click OK to close the dialog box and send the content item to the next step, as described above.
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If you sent the content item to a translation provider, or copied the source content to the target, the Job
Progress box opens, indicating the Connector's progress in sending out the item for translation or
copying over the content. Each target language represents an item. Click Close at any time to close the

Job Progress box. The processing and sending continues in the background.

Job Progress

Send Sitecone items out for ranslation

Sending job "JP5 3. s safe o close the wizard al any time, the job will be sent in background.

Preparing Sending Sentto CTT |  In Transiation Received

| Mumber of [tems 5 14 0 0 0

Preparing ranslation queaus ilams: TH2...

Completad

Important: If the Connector sent the item to the Translation Queue, you must approve it there to send it
out for translation. For detailed instructions, see "Submitting Content for Translation from the

Translation Queue" on page 62.

The page at | 53y

[temn translation: /sitecore/content/Global/ Carousels/Home
Page Caribbean

From: en (V:1)

To: dajd,de-DEJ.fr-FR|O, ja-JP)0, zh-CNID

has been added te CT3 Translation Queue,

0K

Note: The Connector never sends out shared fields for translation, because these fields are shared across all

versions and languages of an item.

For information about the events that occur when the Connector sends out content for translation, see

"Sending Content to Translation" on page 34.

Tip: You can monitor the translation progress from within the Sitecore Content Editor. For detailed instructions,

see "Monitoring Translation Status" on page 69.
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4.3 Submitting Content for Translation from the Page Editor or the Experience Editor

This section describes how to submit a content item for translation using the Sitecore Page Editor (Sitecore 6
and 7) or the Sitecore Experience Editor (Sitecore 8). Depending on your company's Connector configuration,
when you submit the item for translation, either:

B The Connector immediately sends out the item for translation.

B The Connector sends the item to the Translation Queue, which is a holding area for items that are ready for
translation.
For instructions on submitting a content item for translation using the Sitecore Content Editor, see page 62.

1. Do one of the following:

i Sitecore 6 and 7: In the Sitecore Page Editor ribbon, click the CTC Translation tab.

ﬂ ‘ Home  Advanced Experience  Testing Progerties View CTC Translation

A < @
Edit | Preview = Transtate To

Made Tranzlatian

i Sitecore 8: In the Sitecore Experience Editor ribbon, click the CTC Translation tab.

- HOME PRESENTATION EXFERIENCE VERSIONS OFTIMLZATION VIEW CTC TRANSLATION

& [ Q

Eait Other Transtate To

2. Inthe Translation section, click the Translate To button.
Note: This button is displayed only if the content item is in the Reviewing workflow state.

3. Optional. Depending on your company's Sitecore configuration, an additional comment box may be
displayed. If so, you can enter a comment and click OK.

The Automatic Item export for translation dialog box opens.
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Automatic ltem export for translation

Send Sitecore items for translation, automatically

Translate /sitecore/content'Home [ en Vi1 ]
DSEn::I dependent items (0}

Te Language

[] select Al

|:| Japanese (Japan): BFZE HE)

|:| Hebrew (lsrael) : frower) oy

Translation Option
|:| Use Local TM {Only send out changed content for translation).

SEC Fields

[] 5=nd Seo fields
Send Standard fields

S5end To Options
D Send items to translation queue
@ Send items to translation provider

Job Name
Delivery Date 8270
PO Reference

Desoiption
Send for Quote |:|

I:::l Copy source to target only

Ok Cancel

The following options may be available, depending on your company's Connector configuration:

Option Description

Send Select this check box to include items from the layout and final layout that are dependent

Dependent | on the selected content item. This is useful, for example, if a page item has multiple layers

Items with different data sources, and you want to translate all the items displayed in the page.
The number in parentheses indicates the number of dependent items.
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Option Description

To Select the check boxes for the target languages into which you want to translate the
Language content. If you want to translate the content into all available target languages, select the
Select All check box.

Tip: When you select a target language, if an error states that the language code is
misconfigured, it means that you do not have read access to that language. You require
read access to a language to send out content for translation to that language.

Note: Depending on your company's Connector configuration, some languages may already
be selected. If so, you can clear any selected languages that you do not want to include.

Use Local Determines whether to check each field of the source version for any content changes, and
™ send only changed content fields out for translation. If a field was previously translated and
it has not changed, then the Connector does not send it for translation again: Instead, it
uses the stored translation.
When this check box is selected, the Connector sends only changed content fields out for
translation. This may reduce translation costs, but it increases the processing time before
the Connector sends out the items for translation.
When this check box is cleared, the Connector sends all specified source content for
translation, even if it has not changed since it was previously sent for translation.

Note: If the Use Local TM feature is enabled, the Connector checks each field of the source
version for any content changes, and it sends only changed content fields out for
translation, to ensure that all target versions reflect these changes. This option may also not
be available based your company's Connector configuration. For details, refer to the
description of the Use Local TM setting in the Clay Tablet Connector for Sitecore
Installation and Configuration Guide.

SEO Fields | Select the check boxes for the types of content to send out for translation.
Send SEO fields: The Connector sends fields defined in the SEO Fields section of the Clay
Tablet Settings items for translation. Cleared by default.
Send standard fields: The Connector sends the fields specified by the Field Types to be
Sent For Translation parameter in the CT3 Sample Workflow. Selected by default.
For more information, refer to the Clay Tablet Connector for Sitecore Installation and
Configuration Guide.

Select one of the following Send To Options:

Send items | The Connector sends the content item to the Translation Queue, where a user must

to approve it to send it out for translation.
translation
queue
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Option

Description

Send items
to
translation
provider

The Connector sends the content item to the Clay Tablet Platform, which sends it to the
translation provider specified in the company's routing rules. The Connector displays
additional fields below, where you can specify additional information.
Recommendation: Select this option if you need to quickly send out content and do not
need to arrange or filter it, for example, by language.
Send To: If your company has multiple translation providers, and if your company's
Connector configuration enables selecting the translation provider (instead of using
automatic routing rules), you can select the provider for this item in the dropdown list.
Job Name: Your name for this translation job.
Delivery Date: The requested translation deadline. This is the date when you expect the
translated content to return. By default, it is two weeks from the current date. To select a
different date, either type the delivery date in the field in MM/DD/YYYY format, or click
the arrow and select a different date in the calendar that opens. This information is sent
to the translation provider as metadata of the translation package.
Note: The default displayed date is based on your company's Connector configuration.
Recommendation: Discuss with your translation provider whether to use the
information in this field.
PO Reference: The purchase order reference number.
Special Instruction: Any additional instructions for Lionbridge Freeway. Displayed only if
Lionbridge Freeway is selected in the Send to box, above.
Analysis Code: The analysis codes for the translation. Displayed only if Lionbridge
Freeway is selected in the Send to box, above. You specify the analysis codes that are
relevant to your content.

Your Lionbridge setup determines which analysis codes are available for you to specify,
and the values available for selection for each analysis code. In this example, the Region,
Department, and Priority analysis codes are available for you to specify.

Description: A description of the translation job, including any special instructions or
requests. Displayed only if a translation provider other than Freeway is selected in the
Send to box, above.

Send for Quote: Select this check box to inform the translation provider that you want to
receive a quote before the translation process starts. Displayed only if supported for the
selected translation provider and enabled in your Connector installation.

Copy
source to

target only

The Connector copies the source content to the target content item without sending it out
for translation. This is useful when there is content that you do not want to translate, but
that you want to include in the target version. The Connector displays an additional field
below, where you specify the job name.

Job Name: Your name for this job.

4. Click OK to close the dialog box and send the content item to the next step, as described above.
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If you sent the content item to a translation provider, or copied the source content to the target, the Job
Progress box opens, indicating the Connector's progress in sending out the item for translation or
copying over the content. Each target language represents an item. Click Close at any time to close the

Job Progress box. The processing and sending continues in the background.

Job Progress

Send Sitecone items out for ranslation

Sending job "JP5 3. s safe o close the wizard al any time, the job will be sent in background.

Preparing Sending Sentto CTT |  In Transiation Received

| Mumber of [tems 5 14 0 0 0

Preparing ranslation queaus ilams: TH2...

Completad

If you sent the content items to the Translation Queue, a message box opens, indicating that the
Connector sent the content and the source and target languages. Click OK to close the message box.

Important: If the Connector sent the item to the Translation Queue, you must approve it there to send it
out for translation. For detailed instructions, see "Submitting Content for Translation from the

Translation Queue" on page 62.

The page at | says:

[temn translation: fsitecore/content/Global/ Carousels/ Home
Page Caribbean

From: en (V:1)

Teo: dafd,de-DEJ.fr-FR|O ja-JP)0,zh-CHD

has been added te CT3 Translation Queue,

oK

Note: The Connector never sends out shared fields for translation, because these fields are shared across all

versions and languages of an item.

For information about the events that occur when the Connector sends out content for translation, see

"Sending Content to Translation" on page 34.
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4.4 Sending Multiple Content Items for Translation

The Bulk Translation feature enables you to select, send, and receive large quantities of content for translation
in only a few clicks.
This is useful for quickly sending out entire sections, sites, or content trees for translation.

You access the Bulk Translation feature from either the CTC Translation tab on the Sitecore Content Editor
ribbon, or from the Start menu on the Sitecore Desktop (Sitecore 6 and 7 only).

Important: When you use the Bulk Translation tool, you can initially select a large set of content items, based
on the content navigation tree, and then in subsequent steps you exclude items from that group that you do
not want to send out for translation.

Bulk translation and workflow

Recall that you do not need to attach a translation workflow to the content items when you use the bulk
translation feature. However, the Assign Translation Workflow to items with no workflow defined? option in
the wizard enables you to attach a workflow to the items you send out, and you can set the workflow state for
those items. This is recommended because it helps manage those items later, especially in the workbox.

Recommendation: Plot out your requirements before starting the Bulk Translation wizard, because this feature
has powerful implications. Consider the following issues:

B Does every item already have a workflow attached?

B [fevery item does not already have a workflow attached, do you want to attach the translation workflow to
those items?

B |f you want to attach the translation workflow to items previously without a workflow, which workflow state
do you want to assign to those items?

B What are the repercussions of attaching the workflow and assigning the workflow state to these items?

To send content for translation using the Bulk Translation feature:

1. Do one of the following to open the Bulk Translation wizard:

In the Sitecore Content Editor ribbon, click the CTC Translation tab, and then in the Translation Tools
section, click Bulk Translation.

HOME NAVIGATE REVIEW ANALYZE PUBLISH VERSIONS CONFIGURE PRESENTATION SECURITY VIEW CTC TRANSLATION

A Translation Queue 0 Clear backup data

1 Translation Filter [ Translation Status  [#) ftem Translation Details

oW
: I
o

In the Sitecore Desktop, click the Sitecore menu, and then select All Applications > CTC Translation >
Bulk Translation from the menu. (Sitecore 6 and 7 only)

The Settings page of the wizard opens.
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Settings

Select the franslaiion language seflings. Then dick Next fo select items

Source Language

English : English

Translate these items into the following Target Languages

Salact All

de-DE German (Germany) - Deulsch (Deutschland)
fr-FR  French (France) . francais (France)

ja-JF Japanese (Japan)  B#5 (BE)

zh-CH Chinese (Simplified. China) : 3Tt A FE50E

llems to send

® Selectitems to send

Selact ltems sentin past jobs Sort by job name Sort by creation ime
Job Name | Creafion Time
= JPS2 33172015 5:07:49 PM
Y JPS1 33172016 5:07:04 PM
3] Patrick 7 33172016 2:31:47 PM =

Back Cancel

2. Inthe Settings page, you choose the following settings:

Setting Description

Source Language | The Connector will send items in this source language for translation. By default this
is the default Sitecore language. You can select another language from the list.
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Setting Description

Translate these Select the check boxes for all the target languages into which you want to translate
items into the the source content. The list displays all the Sitecore languages that are set up for the
following Target Connector.

Languages Tip: Use the Select All button (Sitecore 6 an 7) or check box (Sitecore 8) to select all

available languages.

Tip: When you select a target language, if an error states that the language code is
misconfigured, it means that you do not have read access to that language. You
require read access to a language to send out content for translation to that
language.

Note: In a later step of this wizard, you can select individual content items from the
list of content items and modify their target languages. This is useful for any specific
exceptions that may require special target language treatment.

Items to send This section displays the names of items you can send for translation and the date
and time they were created. By default, these items are sorted in order of reverse
chronological creation date.

To sort these items by name, click Sort by job name.

To sort these items by date, click Sort by creation date.
You can choose one of the following settings:

Select items to send: This displays all items in the specified source language.

Select items sent in past jobs: This displays all items in the specified source
language that were previously sent for translation.

Note: Later in the wizard you can exclude items from this list.

When you are done, click Next.

Ifin the previous step you selected Select items to send, then the Choose Items page of the wizard
opens. Proceed to the next step.

Ifin the previous step you selected Select items sent in past jobs, then the Translation Options page of
the wizard opens. Proceed to step 8.

3. Inthe Choose Items page, you select the source items to send for translation. You can select individual
items or all the items in a branch. In later steps, you can exclude items so that you do not send them for
translation. If you send content to the Translation Queue, you can further sort and select the items there to
send for translation.
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Choose Items

Choose one or more items and/or branches requiring fransiafion. You can exclude individual items in a later siep

Choose ltems
Send dependent items

4 & Contzn isilecoreicontent/Settings/Comman Text (branch
» -"'. Homea fsitecore/contentMeta-DataStarter Kit Revision (lem only

4 ] Meta-Data
¥ ) Menu-Styles
*® Starter Kit Revision
» o Themes
4 ] Safttings >

b o) Common Text

Note: =2 Addbranch = Add item 'S Remove

Back m Ean DEI

Use the Expand and Collapse icons to navigate the tree, and then use the following buttons to collect the
items and branches of items for translation in the right pane of this page:

Use the following buttons to specify which items to collect for translation:

# Toadd a branch to the right pane, select it and click . Itis displayed in the right pane following by
(branch).

# To add an item to the right pane, select it and click . Itis displayed in the right pane following by
(item).

# Toremove one or more items from the right pane, select them and click .
Tip: If you specify the highest root in your Sitecore project and click , all content from a site or Content
Server, you can send all your project content for translation at one time.

Optional. To include items from the layout and final layout that are dependent on the selected content
items, select the Send dependent items check box at the top of the page. This is useful, for example, if a page
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item has multiple layers with different data sources, and you want to translate all the items displayed in the
page.
Notes: Your company can configure which dependent items the Connector sends for translation when this

check box is selected. It can also configure the default value of this check box. For detailed instructions, refer
to the ClayTablet Connector for Sitecore Installation and Configuration Guide.

When you are done, click Next.

The Specify Source Filters page of the wizard opens.

4. In the Specify Source Filters page, you specify the filters to apply to the source content, which limits the
content that you send for translation. It enables you to apply very specific conditions and precisely control
which content you send out for translation. For example, using the filters on this page, you can select all the
items created by a certain user, during a given date range, and then send only the latest version of those
items.

Important: These filters are inclusive parameters. Only items that match all filter parameters will be available
for further selection on subsequent pages of the wizard.

Specify Source Filters

Specify the fillers that you want o apply o the source. Click Next fo confinue

to@rm version filher

Send only the Latest Version

Creation date filtar

Fram *  Clear Filter

To b

Maodification data filler

From = Clear Filter
To -

Fublizh date filter

Publizh Drate *  Clear Filter

# Take workflow into account
Created by filter

Back Cancel

You can use the following filters:

Clay Tablet Connector for Sitecore User Guide Page 50
Version 3.10.0 June 14, 2017



4 Sending Content to Translation

Filter Description
I[tem version You filter the version or versions of the content items that the Connector sends out for
filter translation. The following options are available:

Send only the latest version: The Connector sends only the latest version of content
for translation. This is the default selection.
Send the latest published version: The Connector sends only the latest published
version of content for translation. This is suitable when a company publishes content
before sending it for translation.
Send all published versions: The Connector sends all published versions of content
for translation.
Send all versions: The Connector sends all versions of content for translation.
Note: If you select one of the last two options, the Connector sends multiple versions of
the same content items for translation.

Creation date
filter

You filter the creation date of the content items that the Connector sends out for
translation. In the From and To fields, either enter the range of content-creation dates in
MM/DD/YYYY format, or click the arrow and select a date from the calendar that opens.

Modification You filter the modification date of the content items that the Connector sends out for
date filter translation. In the From and To fields, either enter the range of content-modification
dates in MM/DD/YYYY format, or click the arrow and select a date from the calendar that
opens.
Publish date You filter the publication date of the content items that the Connector sends out for
filter — Publish | translation. In the Publish Date field, either enter the content-publication date in
Date MM/DD/YYYY format, or click the arrow and select a date from the calendar that opens.
Publish date This setting determines whether the Connector checks the Publish date filter.
filter — Take If this check box is selected (default value), then the Connector includes in the filter
workflow into only items that both match the publish date and those that need publishing to be
account approved through the workflow.
If this check box is cleared, then the Connector includes in the filter items that match
the publish date whether or not publishing must be approved through the workflow.
Created by You create a filter based on who created the content item. This can be either users, or
filter roles assigned to users, or both.

To add a filter to this list, click Add. For detailed instructions, see page 61.
To remove a filter from this list, select it and click Remove.
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Filter Description
Updated by You create a filter based on who updated the content item in Sitecore. This can be either
filter users, or roles assigned to users, or both.

To add a filter to this list, click Add. For detailed instructions, see page 61.
To remove a filter from this list, select it and click Remove.

Tip: To clear the information from any filter, click the corresponding Clear Filter button.
When you are done, click Next.
The Excluding Item(s) page of the wizard opens.
5. In the Excluding Item(s) page of the wizard, you can precisely control the translation parameters for each

content item you sent for translation. This helps you manage any exceptional translation requirements. You
can:

Remove content items from the list, so that you do not send them out for translation.

Note: If you selected the Send dependent items check box at the bottom of the Choose Items page, in
step 4, above, then if you exclude some items from the list, their dependent items will automatically be
excluded.

Change the target language of each item to send out for translation. For example, you may select a
section of your web site to be bulk exported for translation into German, but you want to translate the
top-level page items of that section into Spanish and French too.

Change the version of each item to send out for translation for each target language. For example, you
may want an older version of the source content translated into a specific target language.
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Excluding Item(s)

Remowe the llems that don require franslafion

Targel language and version

= fsitecora‘contentMewsletter Example/lune 2009 - Site:
= sitecore/contentMewsletier ExamplelJune 2009 - Site
J Isitecore/contentMewsletter Example/June 2009 - Site:
] lsitecaralcontantMewsletter ExamplalJune 2009 - Sile:

™| Isitecore/contentNewsletier ExamplelJune 2009 - Site
= sitecore/content™ews|etier Example/June 2009 - Site
(] lsitecore/contentMewsletter ExampletJune 2009 - Sited

[ sitecore/contentMewsletter Example/June 2009 - Site

- == Updaie
] ) a

;IHIHI“ I — i - B i
ﬁ CheckAll | 31 Un-Check Al a Checkabranch = | Un-Check a branch ﬁ;f Ramova O checked itams ou
! | N .

k

ae | (e

To remove one or content items from the list, so that you do not send the out for translation, select the
corresponding check boxes in the left page, and click [&| Remove X checked items out of Y at the bottom
of the list, where X is the number of items that are already selected for removal, and Y is the total number
of items displayed in the list.

Tips: Use the shift key to select a range of adjacent roles or users. Use the Ctrl key to select multiple
non-adjacent roles or users.

Tips: To select all content items in the list, click |E| Check All. To clear the check boxes for all selected
content items in the list, click |E Un-Check All.

Tips about working with branches: To select all the content items in a branch, select one item in that
branch and then click | €| Check a branch. To clear the check boxes for all selected content items in a
branch, click Un-Check a branch.
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To change the target languages and versions to translate, click a content item in the left pane to highlight
it, as shown in the above screen capture. The right pane now displays the target languages set up for the
Connector. Any target languages that you selected earlier, in the Settings page of the wizard, are selected.
You can change this default selection by selecting the check boxes for additional target languages or
clearing the check boxes for selected target languages.

To change the version assigned to the content item, change the version number in the Version box for
the language. If you select Default, the version number is incremented by one.

To save your changes to a target language and version for a content item, click Update at the bottom of

the right pane.

6. When you are done, click Next.

The Translation Options page of the wizard opens.

Translation Options

Choose the translation ophons

Workflow Option: applied to ALL items selecied

[] Assign Translation Workflow to items with no workflow defined?
With state
Reviewing w

Advanced Translation Options

SEO Fields

[] Send Seo flelds
[+] Send Standard fields

Usea Local TM
" Only send fields with changed content. Unchanged fields will have the ariginal translation autormatically copied to the targel version

Send To Oplions
':EZ Send items to translation queue

-::: Send items to translation pravider

() Copy source 1o target anly
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In the Translation Options page of the wizard, you can assign a workflow to items without a workflow, set

the workflow state for the content items you are sending to translation, send only changed content fields for
translation, and decide whether to immediately send the content item out for translation, send it to the
Translation Queue first, or copy the source content to the target version without translating it. You can set

the following options:

Option

Description

Assign Translation
Workflow to items with no
workflow defined?

You can attach a translation workflow to the content items you send out for
translation, and you can set the workflow state for those items. This is
recommended because it helps manage those items later, especially in the
workbox.
Tip: If you initially send out your entire site for translation before setting up
workflow, do not set the bulk items to an initial workflow state.
Note: Depending on your company's configuration, you may not be able to
send out content items for translation unless they are attached to a
translation workflow. You can change this configuration with the
ClayTablet.PreventSentingItemsWithoutWorkflow settingin the
CT3Translation.configfile. For details, refer to the Clay Tablet
Connector for Sitecore Installation and Configuration Guide.
Note: By default, the translation workflow is the CT3 Sample Workflow.
You can set the default workflow state using the
ClayTablet.StateToAssignInBulkTranslation settinginthe
CT3Translation.configfile. For details, refer to the Clay Tablet
Connector for Sitecore Installation and Configuration Guide.
To assign the translation workflow to any content items without a
workflow assigned, select this check box.
To proceed with the translation process without assigning a translation
workflow to content items without a workflow, clear this check box.

With state: If you select this check box, you select the workflow state to
apply to all source content items that previously did not have a translation
workflow assigned. For a list and description of workflow states, see page
34,
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Option

Description

SEO Fields

Select the check boxes for the types of content to send out for translation.

Send SEO fields: The Connector sends fields defined in the SEO Fields
section of the Clay Tablet Settings items for translation. Cleared by
default.
Send standard fields: The Connector sends the fields specified by the
Field Types to be Sent For Translation parameter in the CT3 Sample
Workflow. Selected by default.

For more information, refer to the Clay Tablet Connector for Sitecore

Installation and Configuration Guide.

Use Local TM: Only send
fields with changed
content. Unchanged fields
will have the original
translation automatically
copied to the target
version.

Determines whether to check each field of the source version for any
content changes, and send only changed content fields out for translation.
If a field was previously translated and it has not changed, then the
Connector does not send it for translation again: Instead, it uses the stored
translation.
When this check box is selected, the Connector sends only changed
content fields out for translation. This may reduce translation costs, but
it increases the processing time before the Connector sends out the
items for translation.
When this check box is cleared, the Connector sends all specified source
content for translation, even if it has not changed since it was previously
sent for translation.

Note: If the Use Local TM feature is enabled, the Connector checks each
field of the source version for any content changes, and it sends only
changed content fields out for translation, to ensure that all target versions
reflect these changes. This option may also not be available based your
company's Connector configuration. For details, refer to the description of
the Use Local TM setting in the Clay Tablet Connector for Sitecore
Installation and Configuration Guide.

Note: This option may not be available, based your company's Connector
configuration. For details, refer to the Clay Tablet Connector for Sitecore
Installation and Configuration Guide.

Select one of the following Send To Options:
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Option Description
Send items to translation The Connector sends the content items to the Translation Queue, where a
queue user must approve them to send them out for translation.

Recommendation: Select this option if you want to use the Translation
Queue to batch together many items for translation into many target
languages, but then only immediately send out those items for translation
into a single language.
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Option Description
Send items to translation The Connector sends the content items to the Clay Tablet Platform, which
provider sends it to the translation provider specified in the company's routing rules.

The Connector displays additional fields below, where you can specify
additional information.
Recommendation: Select this option if you need to quickly send out
content and do not need to arrange or filter it, for example, by language.
Send To: If your company has multiple translation providers, and if your
company's Connector configuration enables selecting the translation
provider (instead of using automatic routing rules), you can select the
provider for this item in the dropdown list.
Job Name: Your name for this translation job.
Delivery Date: The requested translation deadline. This is the date when
you expect the translated content to return. By default, it is two weeks
from the current date. To select a different date, either type the delivery
datein the field in MM/DD/YYYY format, or click the arrow and select a
different date in the calendar that opens. This information is sent to the
translation provider as metadata of the translation package.
Note: The default displayed date is based on your company's Connector
configuration.
Recommendation: Discuss with your translation provider whether to use
the information in this field.
PO Reference: The purchase order reference number.
Special Instruction: Any additional instructions for Lionbridge Freeway.
Displayed only if Lionbridge Freeway is selected in the Send to box,
above.
Analysis Code: The analysis codes for the translation. Displayed only if
Lionbridge Freeway is selected in the Send to box, above. You
specify the analysis codes that are relevant to your content.

Your Lionbridge setup determines which analysis codes are available for
you to specify, and the values available for selection for each analysis
code. In this example, the Region, Department, and Priority
analysis codes are available for you to specify.

Description: A description of the translation job, including any special
instructions or requests. Displayed only if a translation provider other
than Freeway is selected in the Send to box, above.

Send for Quote: Select this check box to inform the translation provider
that you want to receive a quote before the translation process starts.
Displayed only if supported for the selected translation provider and
enabled in your Connector installation.
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Option Description

Copy source to target only | The Connector copies the source content to the target content item
without sending it out for translation. This is useful when there is content
that you do not want to translate, but that you want to include in the target
version. The Connector displays an additional field below, where you specify
the job name.

B Job Name: Your name for this job.

When you are done, click Next.

The Summary Report page of the wizard opens.

8. Use the Summary Report page to review the content items you are sending for translation as well as the
target languages, if applicable.

Summary Report

All of the ollowing items will be senl for ranslation

Submifting to Translation Queue
Tramslate From:
English - English

items sent for transiation | Total: 38 lems |

isitecoraiconientMewsletter Example/June 2009 - Sitecore Insitas/Mewsletter Root [V.1] To [de-DE]

‘sitecoreiconiantMawslatter Example/dune 2009 - Sitecore Insitas/Mewslatter RootHeader [V:1] To [de-DE]
'sitecorescontent/Mewsletter Exampletdune 2009 - Sitecore Insites/Mewsletter RootTop Image [V.1] To [de-DE]

'sile coredconiant/Mewsletter Example/June 2009 - Silecore Insilas/Mewslatier Rool'Content Sactions [V:1] Ta [de-DE]
'sitecorescontent/Newsletter Example/dune 2009 - Sitecore InsitlesNewsletter Root'Content Sectionsiniroducing OMS [V:1] To [de-DE]
lsitecorefcontentMewsletter Example/June 2009 - Sitecore Insitas/Newsletter Root'Content Sectionsintroducing OMS/View Prass
Releasa [V:1] To [da-DE]

lsitecoreicontent/Mewsletter Example/une 2009 - Sitecore Insities/Mewsletter Root'Content Sectionsintraducing OMS/Learn About
OMS [V:1] To [da-DE]

'sitecorelicontent/Mawsletter Exampletune 2009 - Sitecore Insites/Mewsletter Root'Content Seclions/Resources [V:1) To [de-DE)
lsitecorafcontentMewsletter Example/Junge 2009 - !

To [de-DE]

lsitecorercontentMewsletter Example/une 2009 -
White Papar [V:1) To [da-DE]
'sitecorescontent/Mewsletter Exampletdune 2009 - !
Guida [V:1] To [de-DE]

'sitecorescontent/Mewsletter Example/dune 2009 - Sitecore Insites/Mewsletter Root'Content Seclions/Resources/Project Managers
Guide/View White Paper [V.1] To [de-DE]

'sitecoreiconiant/Mawslatter Example/une 2009 - Sitecore Insitas/Mewslatter RootContent Sactionsinnovaton Showcase V1] To
Ide-DE]

lsite corefcontantMewsletter Example/June 2009 - Sitecore Insilas/MNewslatler Root'Content Sactionsinnovation Showcasa'LifeScripl
[W:1) To [de-DE]

Eitecnrafrnnient/Mewslatter Framnlallung 2009 - Sitecnra Insiles/MNawslatier Ranl'Content Sactinnsinnovalinn
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Click Submit to send the content items to the next step, which you specified earlier in the Translation
Options page of the wizard.

The final page of the wizard opens, displaying the following information:

The number of content items sent out for translation, to the Translation Queue, or copied over to the
target version without translation.

Whether the items were sent out for translation, to the Translation Queue, or copied over to the target
version without translation.

Important: If the Connector sent the items to the Translation Queue, you must approve them there to
send them out for translation. For detailed instructions, see "Submitting Content for Translation from the
Translation Queue" on page 62.

Alist of all content items, including their paths, that the Connector sent out for translation, to the
Translation Queue or copied over to the target version without translation.

The Bulk Translation wizard has completed.

A total of 883 ems have bean sent for translation:

-
= 1 Isitecorefcontent/ClayTablet/GlobalStrings/DisplayName_CT3Translation

| 2 Isiecore/content/'ClayTablet/GlobalStrings/DisplayMame_TranslatisnWorkflow

g 3 Isitecoreicontent'ClayTablet'GlobalStringsiUl_Sanditems_Quote

= 4 Isitecore/content/ClayTabletGlobalStingsAJI_TnsComection_WelcomePage_Help1

& 5 Isitecore/content/ClayTabletGlobalStrings/DisplayMame_Submit

] B Isilecorefconlent'ClayTablet/Global StringsMHimi_UnArchivelob

2l 7 Isitecore/content/ClayTablet/GlobalStrings/Ribbon_TranslationQueue_AlerTexd_CimSendAll o

Sending job "JPS 1'. It is safe to close the wizard at any time, the job will be sent in background.

Items to send Preparing Sending Sentto CTT In Translation

Mumber of itams: gs3 0 0 0 0
< ¥
150 iterns added 1o translation gueue. 11T
Close
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If you sent the content items to a translation provider, or copied the source content to the target, the Job
Progress box is displayed at the bottom of the page, indicating the Connector's progress in sending out the
items for translation or copying over the content. The Number of Items refers to the number of content
items in the source language. In the other columns, each target language represents an item.
9. Close the wizard:
In Sitecore 6 and 7, click Finish.

In Sitecore 8, click Close.

The processing and sending continues in the background.

4.4.1 Adding a Source Filter when Sending Multiple Items for Translation

The Add an Account dialog box (Sitecore 8) or the Select an Account dialog box (Sitecore 6 and 7) opens when
you click the Add button in the Created by filter section or the Updated by filter section in the Specify Source
Filters page of the Bulk Translation wizard.

You use this dialog box to create a filter for sending bulk content for translation based on roles or individual
users who created or updated the content items.
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Add an Account

Select an account type and then click the relevant role or user

Account Type
* Roles

Users

Search

Emailcampaign\Engagement Automation Meamber
Emailcampaign\Engagement Automation Unsubscribed
Emailcampaign'Jetstream Newslatler Membear
Emailcampaign'Jetstream Newsletler Unsubscribed
exiranabiFregueaniFlyear

exiranebiFreguentFlyarHdH

sitacore\Analylics Advanced Tasting
sitecorelAnalytics Content Profiling
sitacorelAnalylics Maintaining

sitacorelAnalylics Management Repoarting
sitacore\Analylics Personalization

sitacore\Analylics Reporing

By default, this window displays all roles. By default, the items in the list are displayed in alphabetical order.

¥ To display users instead of roles, click Users in the Account Type box at the topic of the window.

Roles are displayed in alphabetical order.
If users are displayed, they are displayed in alphabetical order.

You select the roles for the filter. For example, if you are creating a filter to include only content created by users
assigned to certain roles, you select these roles.

Tips: Use the shift key to select a range of adjacent roles or users. Use the Ctrl key to select multiple non-
adjacent roles or users.

For information about navigating the pages in the list, see "Navigating Pages in a List" on page 16.

When you are done, click OK.

4.5 Submitting Content for Translation from the Translation Queue

You submit content for translation from the Translation Queue in the following scenarios:
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B When you reviewed content, you submitted it to the Translation Queue, by selecting the Send items to
translation queue radio button, instead of immediately sending it for translation, as described in the
previous sections:

# "Submitting a Content Item for Translation using the Content Editor" on page 35
# "Submitting Content for Translation from the Page Editor or the Experience Editor" on page 41
i "Sending Multiple Content Items for Translation" on page 46

B Your company is configured to always submit content items to the Translation Queue before sending them
out for translation.

Submitting content to the Translation Queue before sending it out for translation has the following advantages:

B You may not want to send out each content item individually as soon as you finish reviewing it. The
Translation Queue facilitates your management of reviewed content, so that you do not forget about
sending individual reviewed content items for translation.

B Your translation provider may prefer receiving fewer but larger batches of content to translate, rather than
individual content items, as this facilitates project preparation, resource assignment, and file analysis.

B |fyou want to translate many items into multiple languages, but you want to translate into only one target
language at a time, this is a good way to manage that process.

If you or your colleagues have added content items to the Translation Queue, you must access it and approve
the files you want to send out.

Note: If you do not approve content items in the Translation Queue, the Connector does not send them out for
translation.

When you send content for translation from the Translation Queue, you can add job metadata, including a job
name and a requested delivery date, when the translations will be returned.

Note: These instructions assume you already have content items in the Translation Queue. For information on
submitting content to the Translation Queue, see "Submitting a Content Item for Translation using the Content
Editor" on page 35.

To submit one or more content items from the Translation Queue for translation:

1. Do one of the following to open the Translation Queue:

In the Sitecore Content Editor ribbon, click the CTC Translation tab, and then in the Translation Tools
section, click Translation Queue.

NAVIGATE REVIEW ANALYZE PUBLISH VERSIONS CONFIGURE PRESENTATION SECURITY VIEW CTC TRANSLATION

2 Bulk Translation 4] Translation Queus i Clear backup data

Save i Translation Filter | Translation Status #| Itam Translation Details

In the Sitecore Desktop, click the Sitecore menu, and then select All Applications > CTC Translation >
Translation Queue from the menu. (Sitecore 6 and 7 only)

The Translation Queue opens.

Clay Tablet Connector for Sitecore User Guide Page 63
Version 3.10.0 June 14, 2017



4 Sending Content to Translation 4.5 Submitting Content for Translation from the Translation Queue

Translation Queue

£ @ @ i == &
Remove All  Remove Selected SendAll  Send Selected L Refresh
Estimated words :
2100
Drag a column to this area to group by it Search
icontentHomeProductsVacation-Products master en 1 ja-JPhe-IL Yes 05M10/2017 0442612017 72
icontentHomeProducts master en 1 ja-JRhe-IL Yes 05102017 0412612017 160
icontentHomeProducs/OMce-ProductsDesk-Chairs/The-Standard master en 1 ja-JPhe-IL Yes 05102017 04/26/2017 166
icontentHomeProducts/Office-ProductzDesk-Lampa/Goosy-Swing-Arm master en 1 |a-JEhe-IL Yes 05102017 04/26/2017 152
icontentHome/ProductsiVacation-Products/Swim-Fins master en 1 ja-JRhe-IL Yes 051002017 04/2652017 76
fcontentHome/ProducisHome-Produds/Cool-o-matic master en 1 ja-JRhe-L Yes 05102017 04/26r2017 152
leontentHomeProduds/Ofice-Products/Desk-Lamps master en 1 ja~JPhe-L Yes 05102017 0412602017 &0
icontentHomeProducsVacation-Products/Ski-Gogoles master an 1 ja-JPhe-IL Yes 05102017 04/26/2017 a2
icontentHomeProductsiHome-Products master en 1 ja~JRhe-IL Yes 051002017 04/26/2017 270
icontentHomeProducts/Office-Products/Desk-Lamps/The-Silver-Star master en 1 ja-JPhe-IL Yes 0502017 04/26/2017 164
icontentHame master en 1 ja-JP 06/09/2017 05/28/2017 a0
IcontentHomeProducs/Ofice-ProductsDesk-Chairs master an 1 ja-JPhe-IL Yes 05102017 04/26/2017 22
icontentHomeProducts/Ofce-ProductzDesk-Chairs/Tha-Boss master an 1 la-JFhe-IL Yos 05102017 04/26/2017 138
icontentHomeProducis/Office-Products master en 1 ja-JPhe-IL Yes 05H02017 041262017 &0
fcontentHome/Products/Office-ProductsiDesk-Lamps/Black-Goose master en 1 ja-JRhe-IL Yes 05M02017 04/26/2017 150
icontentHomeProdudsHome-Praduds/Coal-o-matic\Wash-o-matic master en 1 ja-JRhe-IL Yes 05102017 0412612017 216
w
< >

The top of the window displays the total number of estimated words in all the content items in the queue.

The window displays all the content items in the queue that you submitted.

Note: You can group the content items by column. For detailed instructions, see "Grouping Content Items
by Column" on page 19.

Note: If you are assigned to the sitecore\Translation Administrator role, the Show queue items
from all users check box is displayed. To view all items in the queue, select this check box.

The window displays the following information about the content items in the queue:

Column Description

Item The path and name of the content item.
Path

Database | The database that stores this content item.

Language | The language code of the source language of the content item to send for translation.

Version The version of the content item to send for translation.

Translate | Thelanguage codes of the target languages into which to translate the content item.
To
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Column Description

Local TM | Indicates whether the Use Local TM feature is enabled for this content item. This feature
sends only changed content fields out for translation, which reduces translation costs.
B |fthis column has a value of Yes, then this feature is enabled for this content item.

m [fthis column is blank, then this feature is not enabled for this content item.

Deadline | Therequested date for received the translated content back from the translation provider, in
MM/DD/YYYY format.

Created The date when the source content item was created, in MM/DD/YYYY format.

Words The number of words in the content item.

User The user who submitted this content item to the queue. Displayed only if you are assigned to
the sitecore\Translation Administrator role, and if you selected the Show queue
items from all users check box, described above.

Note: To change the number of items displayed on a page in the queue, select a number from the Page size
dropdown list. By default, 20 items are displayed on a page.

2. Do one of the following:
# Select one or more content items to send for translation, and click Send Selected.

Tips: Use the shift key to select a range of adjacent items. Use the Ctr1 key to select multiple non-
adjacent items.

# Click Send All.

The Send Items Out for Translation dialog box opens.
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Send Items out for Translation

tems o fion

— Jending 3 itern(s) out for

. @) y (s)
® tenslation () Copy 2 itami(s) from sourca to target language

Job Mame
Delivery Date SH2i2017 -
PO Reference

Description

Sendfor Quote [

3 items to send (estimated words: 400) Remove > <Add 12 more items in gueue
_ A
[£] IsitecoreicantentHomeProducis/OMce-Products Des k-Chairs/The-Standard |4 feomentHomelProductsvacation-Products
[F isttacoreicontentHomeProducs/Home-Produds/Cool-o-matic & fcontantHomelProducts
£ isitecoreicontentHomeProdudsiVacation-Products/Ski-Goggles [E fcontenvHomeiProductsiOffice-Producis/iDesk-Lamps/Goosy-Swing-Arm

[& fcontentHomefProductsiacation-Products/Swim-Fins

[ reontentHemelProductsiOfice-ProdudsiDesk-Lamps

oK Cancel

The items you selected to send are in the items to send pane on the left. If you did not select all the items in
the queue, then the items you did not select are in the items in queue pane on the right.

3. Choose one of the following:

To send the selected items to your translation provider, select Sending X items for translation to, where
X is the number of selected items. If your company has multiple translation providers, and if your
company's Connector configuration enables selecting the translation provider (instead of using automatic
routing rules), you can select the provider for this job in the Send item(s) to dropdown list.

Enter the following information about the job in the fields at the top:

Option Description

Job Name Your name for this translation job.
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Option Description
Delivery The requested translation deadline. This is the date when you expect the translated
Date content to return. By default, it is two weeks from the current date. To select a different
date, either type the delivery date in the field in MM/DD/YYYY format, or click the arrow
and select a different date in the calendar that opens.
This information is sent to the translation provider as metadata of the translation
package.
Note: The default displayed date is based on your company's Connector configuration.
Recommendation: Discuss with your translation provider whether to use the
information in this field.
PO The purchase order reference number.
Reference
Description | Adescription of the translation job, including any special instructions or requests.
Displayed only if a translation provider other than Freeway is selected in the Send to
box, above.
Send for Select this check box to inform the translation provider that you want to receive a quote
Quote before the translation process starts. Displayed only if supported for the selected
translation provider and enabled in your Connector installation.
Special Any additional instructions for Freeway. Displayed only if Freeway is selected in the
Instruction | Sending items for translation to box, above.
Analysis The analysis codes for the translation. Displayed only if Freeway is selected in the
Code Sending for translation items to box, above. You can specify the following types of
analysis codes:
Region: The region relevant to the content. Your Lionbridge setup determines which
regions are displayed in the list.
Department: The department relevant to the content. Your Lionbridge setup
determines which departments are displayed in the list.
Priority: The priority relevant to the content. Your Lionbridge setup determines which
priorities are displayed in the list.

This information is delivered to your translation provider along with the content items for translation.

To copy over the selected items to the target version, without translating them, select Copy X items from
source to target language, where X is the number of selected items.

4, Optional. To add other items to your job, select them in the more items in queue pane on the right and
click Add.

Note: To remove items from your job, select them in the items to send pane on the left and click Remove.
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4.5 Submitting Content for Translation from the Translation Queue

5. To send theitems for translation or copy the source to the target, without translation, click OK.

The Job Progress box opens, indicating the Connector's progress in sending out the items for translation or
copying over the content. Each target language represents an item.

Job Progress

Send Silecore ilems out for ranslation

Preparing translation queus [lams: TH2..

Sending job "JPS 3. It is safe (o close the wizard al any time, the job will b& sent in background.

Senlte CTT | In Translation Received Compleled

Preparing Sending

| Number of [tems: 5 14

6. Click Close at any time to close the Job Progress box. The processing and sending continues in the

background.

Tip: To monitor the translation progress, In the Translation Tools section of the CTC Translation tab, click
Translation Status. For detailed instructions, see "Monitoring Translation Status" on page 69.
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5 Monitoring Translation Status

5.1 Translation Statuses

You can track the status of your translation jobs from within the Content Editor, from the CTC Translation tab
on theribbon. There are three ways to monitor the translation status:

B View the status summary, as described on page 70.

B View the status of a single item, as described on page 74.

B View the status of all items in your job, as described on page 71.

For a list and description of translation statuses, see "Translation Statuses" on page 69.

5.1 Translation Statuses

Content items have one of the following translation statuses:

. Percentage

Translation . .

Description Translation
Status

Complete

Error Only | Displayed only in the Status dropdown list in the Translation Status window. N/A

Displays only items with errors in the translation process, including errors that

occur when the Connector sends out or receives translations, and errors

reported back by the translation connector.

Note: Some items may have errors while others are processed normally.
[In Queue] | The Connector sent the item to the Translation Queue. It must be approved in 0%
Wait for the queue before the Connector sends it out for translation.
approval
Preparing The Connector is preparing to send out the item to the translation provider. 1%
Sending The Connector is preparing to send out the item to the translation provider. 1%
Sent to CTT | The Connector is preparing to send out the item to the translation provider. 2%
Sent to LSP | The Connector completed sending out the item to the translation provider. 5%
In The translation provider has received the item for translation and has not yet 10%
Translation | returned the translated item.
Received The Connector received the translated item back from the translation provider. 90%
Not Yet Displayed only in the Status dropdown list in the Translation Status window. 0%-90%
Completed | Displays only items that do not have Completed status, as described below.
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5.2 Viewing Your Translation Status Summary

. Percentage

Translation . ]
Description Translation
Status
Complete

Completed | The Connector has returned the translated item to Sitecore. 100%
No field to | There are no fields to translate in the content item. (The fields may have been 100%
translate excluded by the Translation Filter or the filter in the Bulk Translation wizard.)

5.2 Viewing Your Translation Status Summary

You can view a summary of the translation status of all content items in this Sitecore instance.

¥ To view this summary, on the Sitecore Content Editor ribbon, click the CTC Translation tab. The summary is
displayed on the Translation Statuses section of CTC Translation tab.

HOME NAVIGATE REVIEW ANALYZE PUBLISH VERSIONS CONFIGURE PRESENTATION SECURITY VIEW CTC TRANSLATION
- '_ Bulk Tranzlaton .': Translation Queue .L Claar backup data
Save i Translation Filter |l Tramslation Status # Item Translation Details
The following information is displayed about your content items:
Percentage
Information | Description Translation
Complete
In Queue The number of content items in the Translation Queue. 0%
Preparing The number of content items that the Connector is preparing to sent to the | 1%
Clay Tablet Platform.
Sending The number of content items that the Connector is currently sending to the | n/a
Clay Tablet Platform.
Sentto CTT | The number of content items that the Connector sent to the Clay Tablet 2%
Platform, which is currently preparing to send them out for translation.
Sent to LSP | The number of content items that the translation vendor has received to 5%
translate.
In The number of content items that the translation vendor has received to 10%
Translation | translate.
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Percentage
Information | Description Translation

Complete
Received The number of translated content items that the Connector has received 90%

back from the translation provider.

Completed | The number of translated content items that the Connector has returned to | 100%
Sitecore.

Jobs The number of translation jobs that the Connector has sent out for n/a
(Archived) translation. Ajob includes one or more content items. The number of
archived jobs is in brackets.

Backup The number of content items for which the translations are backed up. n/a
Translations

Archived The number of archived content items. n/a
CTT Log The number of CTT log files that are in the $ (dataFolder) /Logs/ folder. n/a
Files

5.3 Monitoring Status for Multiple Items

You can view the translation status of multiple content items from either the Sitecore Content Editor or the
Sitecore Desktop. You can also view error messages from the translation provider (LSP) about items displayed in
the window.

¥ Do one of the following to open the Translation Status window:

In the Sitecore Content Editor ribbon, click the CTC Translation tab, and then in the Translation Tools
section, click Translation Status.

HOME NAVIGATE REVIEW ANALYZE PUBLISH VERSIONS CONFIGURE PRESENTATION SECURITY VIEW CTC TRANSLATION

2 Bulk Tranzlation 3] Translation Queue g Clear backup data
i Translation Filter | Translation Status «| Item Translation Details

In the Sitecore Desktop, click the Sitecore menu, and then select All Applications > CTC Translation >
Translation Status from the menu. (Sitecore 6 and 7 only)

The Translation Status window opens, displaying the translation status of all content items that you submitted.

By default, the content items are sorted by path. For information on changing the sort order and other features
when working with lists, see page 15.
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Translation Status O X
= e . i@ < — &
Open Selected tems Update Remote TM  Archive Job Refresh
IDrag a column to this area to group by it Search:
fcontentHome sa-IN 3 0 Mew Translation ba327209-3034-43a4-aMB-dacsi9d0ZedBl Sentto LSP 9 53] N7
fcontentHome ja-JP 5 o MNew Translation 4deS564fa-cdci-4ced-b705-65c21bb17320 Sentio LSP o 5% 0n7e
fcontentHome/About-Lis/Our-History fi-FR 1 o Mew Translation debf3106-a37b-4eB1-a47a-eedB7613b01e Completed [100% | 01175
fcontentHome/About-Us/Our-History ia-JP 30 New Translation b978d4ba-T279-4che-b177-3580188ecSa  Completed [100% | 011874
fcontent™ome/About-Ls fr-FR i) Mew Translation 0b7cOebd-1cc8-47d6-a7Ta-Td3aBi49aelT | Completed [100% | o118n
fcontantHomea/About-UsiCur-History sa-IN 1 [i] Mew Translation b2a30376-4a13-4243-ac1a-99846326a736  Complated 100% o1nan
feontentHomealAbout-Us sa-IN ] o MNew Translation b2a303Te-4a13-4243-3c1a-99846326a736  Completad o118rn
fconfentHome/About-Us/Our-History fi-FR 5 0 Mew Translation 0b7clebd-1ccB-47d6-a77a-7d3ak340ae87  Completed [100% | 01187
fcontentHome/About-Us ja-JP 3 ﬁ New Translation bO978d4ba-7279-4che-b177-31580188ec5a Completed [100% | 018
icontentHome/About-Us/Our-Values fi-FR 70 Mew Translaion 0bTcOebd-1ccB-4Td6-a77a-7d3ab349ae87 | Completed [100% | 01185
fcontantHomea/About-Uis/Our-Values |a-JF 3“ MNaw Tranzlation bS978d4ba-T279-4che-b177-31580188ec5a Complatad [100% | o1an
fcontentHome/About-Us/Our-Values sa-IN 10 MNew Translation b2a30376-4ai3-424a-ac1a-00846326a736  Completed 100% 0118n
fcontentHome fi-FR 3 o New Translation ced9a0f-9e88-4524-a18c-933cad1b5Ba Completed 100% 0nTe
fcontentHome s8-IN 4 o Mew Translation 87c01fia-cO08-4 1bb-Dela-fRI4fd20b5cf Sent o LSP o f5%] QTR =
" -

If you are assigned to the sitecore\Translation Administrator role, the following check boxes are
displayed:

B Show jobs from all users: Select this check box to view all submitted content items.
B Show archived jobs: Select this check box to view archived jobs.

This window displays the following information about each content item:

Column Description

Iltem The path and name of the content item.
Path

Language | The target Connector language code for the content item.

Version The incremental version number of the source content item.
If the target version (translation) of an item is not the latest version, then, in the Version column:

B The version number is displayed in bold.

B An information icon is displayed. Clicking this icon displays a message that the current
translated item is not the latest version of the item.
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Column Description

Type This is one of the following:

B New Translation:New translation requested.

B Fix Translation: Translation correction requested.

B Use Local TM: New translation requested for changed content. For unchanged content, the
Connector copies the original translation to the target version.

B Copy to Target:Source content copied to target without translation.

Provider | The Lionbridge Freeway project ID. Displayed only when the translation provider is Lionbridge
Ref Freeway.

Status The translation status of the content item. For a list and description of translation statuses, see
page 69. If an error has occurred, the status is displayed in red. To view details about the errorin
the translation process, click the error icon . Amessage box opens, displaying identifying

information and the error message.

Percent The percentage of the content item that has been translated, which is based on the translation
status. For details, see page 69.

Tip: To view identifying information about this item, click the percentage. This information is
useful when contacting Clay Tablet Technical Support. For example, if your translation is delayed
but an error is not displayed, this information can help Clay Tablet Technical Support determine
the reason for the delay.

ETA The date that the translation provider expects the translation of the content item to be
complete, in MM/DD/YYYY format.

Updated | The date the content item was updated, in MM/DD/YYYY format.

Actions
You can perform the following actions in the Translation Status window:

F To change the number of items displayed on a page in the window, select a number from the Page size
dropdown list. By default, 20 items are displayed on a page.

F To display only content items for a particular translation job, select the job from the Job dropdown list and
click Refresh.

P To display only content items with a particular translation status, select the status from the Status dropdown
list and click Refresh.

Note: You can select Error Only, to display only items with error messages about the translation process.
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To update a remote TM (translation memory) server with the latest changes from multiple items in a single
translation job, select the job from the Job dropdown list, then select multiple items, and click Update
Remote TM. For detailed instructions, see "Updating a Remote TM for Multiple Iltems" on page 103.

To archive a completed job so that it will no longer be displayed in this window, select it from the Job
dropdown list, and click Archive Job. A message box opens, confirming that you want to archive the specified
job. Click OK to proceed. Available only if you are assigned to the sitecore\Translation
Administrator role. For detailed instructions, see "Archiving Completed Jobs" on page 93.

Recommendation: Archive only completed jobs. If you archive a job that is in progress (for example, with In
Translation status), then the Connector will no longer process the content items in that job.

To un-archive an archived job so that it that it is active again, select it from the Job dropdown list, and click
Unarchive Job. A message box opens, confirming that you want to un-archive the specified job. Click OK to
proceed. Available only if you are assigned to the sitecore\Translation Administrator role.

To specify the number of items displayed on a page, select it from the Page size list. You can select from 20
(default), 50, 100, and 200. Use the scroll bar to scroll down to the items at the bottom of the page.

To view one or more content items, select them, and click Open Selected Items. Each content item opens in
the Content tab in a separate browser window.

If the translation has Completed status, the Content tab displays the translated version.

Ifthe translation has Sent to CTT status (for a correction request), the Content tab displays the
translated version.

Otherwise, the Content tab displays the source version.

To refresh the list of content items in the window based on a new selection in the Job or Status filters, or
newly created content items, click Refresh.

To navigate to another page in the list, click a button in the navigation bar below the list. For detailed
instructions, see page 16.

To group content items by a column, click the column heading. While you hold down the cursor, drag the
column heading to the Drag a column to this area to group by it area above the list on the left. For details,
see page 19.

To search for one or more content items in the list, enter the search criteria in the Search box in the top right
corner of the list, and press Enter. The Connector searches all columns and displays only items that match
the search criteria.

5.4 Monitoring Status for a Single Item

You can view the translation status of a single content item, or of a group of content items under a common
root folder.
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HOME NAVIGATE REVIEW ANALYZE PUBLISH

VERSIONS

CONFIGURE

5.4 Monitoring Status for a Single Item

Navigate to the content item whose translation status you want to check.
In the Sitecore Content Editor ribbon, click the CTC Translation tab.

In the Translation Tools section, click Item Translation Details.

PRESENTATION SECURITY

MY TOOLEAR

[#] Transiation Status «| Item Transiation Details

L:] (gl Bulk Tranz|ation [d) Translation Queus & Clear backup data ,
Save il Translation Filter :

The Translation Status tab for the content item opens.

Translation Stalus

|=] fcontentHome

I fcontantHaoma

[& ‘contentHome

& icontentHome

Translated |

Translafion Status

Last Update

THS Type

en V1] de-DE f-FR 342016 2:20:37 PM [In Queue] Wait for approval 3M42016 22037 PM Queuved Translafion Mo
en V1] de-DE 3292016 1135011 AM Saending . IR92016 11:30:11 AM Sending Translation Mo
&n [V:1] de-DE 3282016 11:39:10 AM Sending .. 3292016 11:38:10 AM Sending Translation No
en V2] de-DE [V:8) 4172016 12:53:14 PM g, | Completed 412016 125711 PM New Translation Yes

This tab displays the following translation-status information about the selected content item and any child

items:

Note: The Translation tab is blank if either the content item has not been sent for translation, or it was sent
to the Translation Queue, and then it was removed from the queue.

Column

Description

Item

This is the item path and name. The preceding icon indicates the translation status, as
described below:

] One of the following statuses: Completed; No field to translate.
] All other statuses.

For a list and description of translation statuses, see page 69.

Source

The ISO code of the source language and the version number of the source content. For
example, if this content item is in English, and it is the first version, thisisen [V:1].

Target

The regional ISO code of the target language and the version number of the target
content. For example, if this content item is in Japanese, and it is the first version, this is
ja-JP [V:1].

Note: If there are multiple translation targets, then multiple regional ISO codes and
version numbers are displayed.
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Column Description

Created The date and time when the content item was created, in the following
format: MM/DD/YYYY HH:MM:SS.

Translated A percentage indicating how much of the content item has been translated. This is based
on the translation status, which is described in "Translation Statuses" on page 69.

Translation For a list and description of translation statuses, see page 69.
Status

Last Update The date and time when the content item was last updated, in the following
format: MM/DD/YYYY HH:MM:SS.

TNS Type Translation type. This is one of the following:

B New Translation:New translation requested.

B Fix Translation: Translation correction requested.

B Use Local TM: New translation requested for changed content. For unchanged
content, the Connector copies the original translation to the target version.

B Copy to Target:Source content copied to target without translation.

B Queued Translation:Contentisin Translation Queue.

TNS Backup Indicates whether the translation of the content item is backed up in the database. It has
one of the following values:

H Yes

" No

Note: This is determined by the ClayTablet.BackupTranslationData setting in the
CT3Translation.configfile. For details, refer to the Clay Tablet Connector for
Sitecore Installation and Configuration Guide.

Reference The regional ISO language code and version of an item.

B Foran item that has not been sent out for translation yet, for example, an item in the
Translation Queue, it refers to the source language and version of the item that will be
translated.

B Foran item that has already been sent out for translation, it refers to the target
language and version.

Actions

When you are viewing the translation status, you can also perform the following actions:

=i
F To refresh the translation status information for the content items in the list, click the Refresh button at
the top of the tab.
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To remove a content item from the Translation Queue, so that the Connector will not send it for translation,
select it, right-click, and select Remove from the Translation Queue from the context menu. Available only
for items that have not been translated yet and are in the Translation Queue, with [In Queue] Wait for
approval or Sent to CTT status.

To approve a content item for translation in the Translation Queue, so that the Connector will send it for
translation, select it, right-click, and select Approve this queue item for translation from the context menu.
Available only for items that have not been translated yet and are in the Translation Queue, with [In
Queue] Wait for approval or Sent to CTT status.

To update a remote TM (translation memory) with source content that was edited after it was sent for
translation, select it, right-click, and select Send post-edited content to Update a remote TM from the
context menu. Available only for items that have already been translated, with Completed status. For
details, see "Updating a Remote Translation Memory (TM)" on page 100.

To request a correction of translated content, select the corresponding source content item, right-click, and
select Request Translation Correction from the context menu. Available only for items that have already
been translated, with Completed status. For details, see "Requesting Translation Corrections" on page 97.

To update additional target languages to match the updated translated content, select the corresponding
source content item, right-click, and select Synchronize Translated Versions from the context menu.
Available only for items that have already been translated, with Completed status. For detailed instructions,
see "Synchronizing Translation of Other Target Languages" on page 95.
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6 Monitoring Items in a Workflow with the Enhanced Workbox

Clay Tablet's optional enhanced Workbox has more features than the standard Sitecore Workbox. These
features help you manage large lists of content items in a workflow. You can sort by different column headings,
approve many items at once, and easily manage the display of long lists.

Important: The enhanced Workbox is an optional feature that replaces the standard Sitecore Workbox. It must
be installed as a separate package. For installation instructions, refer to the Clay Tablet Connector for Sitecore
Installation and Configuration Guide.

You open the enhanced Workbox the same way that you open the standard Sitecore Workbox.

To open the enhanced Workbox:

B |n the Sitecore Desktop, click the Sitecore menu, and then select All Applications > Workbox from the
menu. (Sitecore 6 and 7 only)

B |n the Sitecore Content Editor, either:
i Click the Workbox link in the bottom left corner of the Content Editor.

i# Click the dropdown arrow in the top right corner of the Content Editor and select the Workbox link.

When you open the Workboyx, it displays all content items in a workflow, grouped first by workflow (if multiple
workflows are selected), and then by workflow state.

[ Analytics Testing Workflow L tems perPage: | 10 |~ | & Refresh Language: | —ALL - ~ | Figld: | Name V| [] Descending
[ Analytics Workflow v

CT3 Samphe Workflow

Editing - (None)

Reviewing - (954 items)

In Translation - (2 iterns)

Editing Translated Viersion - (4582 items)

Reviewing Translated Version - (2 items)

In the enhanced Workbox, you can perform actions on all content items in a workflow, on all content items in a
workflow state, or on individual content items.

B Forinformation about displaying content items in the Workbox, see page 79.

B Forinformation about viewing and receiving updates for all content items in a workflow, see page 80.

B Forinformation about viewing and receiving updates for all content items in a workflow state, see page 80.
B Forinformation on viewing detailed information about content items, see page 81.

B Forinformation on changing the workflow state of a single content item, see page 83.
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Monitoring Items in a Workflow with the Enhanced Workbox 6.1 Displaying Content Items in the Workbox

For information on changing the workflow state of multiple content items, see page 85.

For information about comparing multiple version of a content item, see page 87.

For information on viewing the history of workflow-state changes to a content item, see page 86.

6.1 Displaying Content Items in the Workbox

The Workbox ribbon includes many features for controlling which content items to display in the Workbox and
how to display these items.

— ) ~ tems per Page: [ 10w & Rafrash Language ALL w Field- | Name |~ | [[] Descending
[ €T3 Sampie Workfiow
W

I [ VTR I T ——

Ribbon

Description of Functionalit
Section P y

Workflows | Select the check box for one or more workflows. The Workbox displays the content items
assigned to these workflows. The top-level grouping of content items is by workflow.

View In the Items per Page dropdown list, select the number of content items to display within a
page in a workflow-state section, or select 211.
Note: You can click page numbers in the bottom-right corner of each page to navigate.

Filter In the Language dropdown list, select the language of the content items to view, or to view

content items in all languages, accept the default, -- ALL --. Depending on the workflow

state of the content item, this may be the source or target language:

B Editing, Reviewing, Sending for Translation,and In Translation workflow
states: source language of the content item.

B Editing Translated Version, Reviewing Translated Version, and Done
workflow states: target language of the content item.

Sort In the Field dropdown list, select the field for sorting the content items in the Workbox. By
default, the content items are displayed in descending order by the specified field. To sort the
content items in ascending order, clear the Descending check box.

Note: All content items are grouped first by workflow and then by workflow state before they
are sorted.

F To refresh the Workbox based on your changes, click Refresh |&&| .

6.2 Viewing Workflow Details and Receiving Updates

You can view the number of content items in a workflow and subscribe to updates about these items.
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W orkbox Updates

b If the workflow section is not already expanded, click & (Sitecore 6 and 7) or EZ} (Sitecore 8) to expand it.

[ Analytics Testing Warkflow . tems per Page: | 10 . & Refresh Language: | —ALL - ~ Figld: | Mame . [] Descending

[ Analytics Worikflow v

[Editing - (None)

[Editing Translated Version - (4582 items)

Reviewing Translated Version - (2 tems)

You can now see the all the workflow states in the workflow, and the number of content items assigned to
each workflow state.

You can perform the following actions:

F To subscribe to an RSS feed of a workflow, so that you will be modified of any workflow-state changes to
content items assigned to this workflow, click in the top-right corner of the workflow section.

F To collapse an expanded workflow section, click e .
F To close a workflow section, click the Close (X) box in the top-right corner.

Note: This clears the selected check box for the workflow, in the Workflows section of the ribbon.

6.3 Viewing All Content Items in a Workflow State and Receiving Updates
You can view the content items in a workflow state and receive updates about them.
1. If the workflow section is not already expanded, click & to expand it.

2. Click (Sitecore 6 and 7), click EZ1 or click the title, which is the name of the workflow state, to expand the
corresponding workflow-state section.
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6.4 Viewing Content Item Details

[ Analytics Testing Workflow A ltemsperPage | 10|v| & Refresh Language: | English [v]  Fiels [ Name [v] [JDescending

[ Analytics Workllow v

CT3 Sample Workflow 3 oA X

Editing - (3 items)

\"_‘j 0 - {English, version 1

Last change: admin changed from Reviewing lo Editing on Friday. March 25, 2016.
Comments: comments More v
Preview Open Diff  Submit

@ 0-(English, version 1)

Last change: admin changed from Reviewing to Editing on Friday, March 25, 2016
Comments: comments More «

Preview Open Diff  Submit

# 0-(English. version 1)

Last change: admin changed from Reviewing to Editing on Tuesday, March 15, 2016
Comments: Reviewing More ~

Preview Open Dif  Submit

Submit (selected) Submit (all} Toggle checkboxes

You can now see all the content items in that workflow state.

In the screen captures, the content items assigned to the CT3 Sample Workflow workflow are displayed
in the Workbox. The section for the Editing workflow state is expanded, while the sections for the other
workflow states are collapsed.

Note: If the number of items in a workflow state exceeds the number specified in the Items per Page setting,
click a number in the bottom-right corner of the section to navigate to a different page, where you can see
additional content items. To change the Items per Page setting, select another number, or 211, from the
dropdown list in the View section of the Workbox ribbon.

You can perform the following actions in a workflow-state section:

¥ To subscribe to an RSS feed of a workflow state, so that you will be notified of any workflow-state changes
to content items in this state, click || .

b To collapse an expanded workflow-state section, click |3|, or click the title of the section.
¥ To view details about the content items in this state, see page 81.

¥ To change the workflow state of a single content item, see page 83.

¥ To change the workflow state of multiple content items, see page 85.

k' To view the history of workflow-state changes to a single content item, see page 86.

¥ To compare multiple versions of a single content item, see page 87.

6.4 Viewing Content Item Details

You can view detailed information about a content item in a specific workflow and workflow state.
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1. Ensurethat the section for the workflow to which the content item is assigned is displayed in the Workbox. If

it is not displayed, select the corresponding check box in the Workflows section of the Workbox ribbon. For
details, see page 79.

2. Ensure that the section for the workflow to which the content item is assigned is expanded. If it is not
expanded, click & to expand it.

3. Ensure that the section for the workflow-state section to which the content item is assigned is expanded. If it
is not expanded, click [53], or click the title of the section, which is the name of the workflow state, to expand

Reviewing - (18 fems)

In Translation - (None)

Editing Tranziated Version - (15 tama) oW

Reviewing Translated Version - (2 iems

[0 &3 About-Us- Japanese (Japan), version 2)
Last change: admin changed from Editing Translated Version to Reviewing Translated Viersion on Tuesday, April 25, 2017,
Comments: More =
Preview Open Diff Publsh Reject

O ‘a Cool-o-matic - (Japanese (Japan), wersion 2)
Last change: admn changed from Editing Translated Version to Reviewing Translated Version on Tuesday, April 25, 2017.
Comments: Morew
Preview Open Diff Publish Reject

Publsh (selected) Publsh (all} Reject (selecied) Reject (all

When a workflow-state is expanded, you can see detailed information about a content item. The screen
capture shows the section for the Editing Translated Version workflow state collapsed, while the
section for the Reviewing Translated Version workflow stateis expanded. The information in
brackets below indicates the information in the highlighted area in the screen capture above.

# The name of the content item (About-Us).
¢ The language of the content item (Japanese, Japan). Depending on the workflow state of the content
item, this may be either the source or the target language:
= Editing, Reviewing, Sending for Translation,and In Translation workflow states:
source language of the content item.
Editing Translated Version, Reviewing Translated Version, and Done workflow states:
target language of the content item.
# The version number of the content item in the specified language (version 2).
# The last change in the workflow state of the item, the user who made this change, the previous and
current workflow states, and the date of this change (admin changed from Editing Translated
Version to Reviewing Translated Version on Tuesday, April 25, 2017.).

You can also perform the following actions on any content item:
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6 Monitoring Items in a Workflow with the Enhanced Workbox 6.5 Changing the Workflow State of Individual Content Items

k' To open a content item in the Sitecore Content Editor, click the name of that item or click Open .

F To view a preview of a content item in the layout for the current device, click Preview || .

6.5 Changing the Workflow State of Individual Content Items

You can change the workflow states of one or more content items in a workflow. The changes you can make
depend on the workflow state of the items.

1. Ensurethat the section for the workflow to which the content item is assigned is displayed in the Workbox. If
it is not displayed, select the corresponding check boxin the Workflows section of the Workbox ribbon. For
details, see page 79.

2. Ensure that the section for the workflow to which the content item is assigned is expanded. If it is not
expanded, click & to expand it.

3. Ensure that the section for the workflow-state section to which the content item is assigned is expanded. If it
is not expanded, click |23, or click the title of the section, which is the name of the workflow state, to expand

0 & AboutUs . English, varsien 1)
Last change: No changes have been made

Wore =

Preview Open DOiff Pubish Reject Translale

| ‘i Black-Goose - (Engish, version 1)
Last cha.l'lg!: Mo Cn!ﬂgeﬂ have Deen made.
More =

Preview Ope Diff Publish Rejgct Tranglale

R R R T ST R Ly S

The screen capture shows the section for the Reviewing workflow state expanded. In this state, the Publish
action is available.

4. You can perform one of the following state-specific actions. The available actions depend on the content
item's workflow state. Refer to the table below for a list and description of actions you can perform on
content items in different states of the CT3 Sample Workflow workflow.
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6.5 Changing the Workflow State of Individual Content Items

Action

Description

Available in these Workflow States

Editing

Reviewing

In
Translation

Editing
Translated
Version

Reviewing
Translated
Version

Submit

Submits a content item to
the next workflow state.

v

Publish

Publishes the content

item:

B Reviewing: publishes
in the source language.

B Reviewing
Translated
Version: publishes in
the target language.

Reject

Rejects the content item,
so that it is not
publishable:

B Reviewing: rejects
content in the source
language.

B Reviewing
Translated
Version: rejects
content in the target
language.

Translate

Opens a dialog box for
specifying translation
settings before sending
this content item for
translation.

Language
Translated

Moves a content item to

the next workflow state,
Editing Translated

Version.

Clay Tablet Connector for Sitecore User Guide

Version 3.10.0

Page 84
June 14, 2017




6 Monitoring Items in a Workflow with the Enhanced Workbox 6.6 Changing the Workflow State of Multiple Content Items

6.6 Changing the Workflow State of Multiple Content Items

You can perform any workflow-state-specific actions on multiple content items that are in the same workflow
state. For example, you can publish or reject multiple content items in the Reviewing Translated
Version workflow state. Different actions are available, depending on the workflow state, as described in
"Changing the Workflow State of Individual Content Items" on page 83.

To change the workflow state of multiple content items:
1. Ensure that the section for the workflow to which the content item is assigned is displayed in the Workbox. If

it is not displayed, select the corresponding check box in the Workflows section of the Workbox ribbon. For
details, see page 79.

2. Ensure that the section for the workflow to which the content item is assigned is expanded. If it is not
expanded, click & to expand it.

3. Ensure that the section for the workflow-state section to which the content item is assigned is expanded. If it
is not expanded, click [3], or click the title of the section, which is the name of the workflow state, to expand
it.

4. Optional. Select the check boxes for the content items for which you want to perform the common action.
Note: If you want to perform the action on all the content items in the workflow-state section, skip this step.

5. Ifnecessary, scroll down to the bottom of the page of the workflow-state section, so that the toolbar at the
bottom of the section is displayed.

Editing - [None
Revicwing - (18 fems)

In Tranglation - (None)

Editing Translated Version - (16 tems)

Reviewing Translated Verzion - (2 tams

Eﬂ About-Us - (Japanese (Japan), version 2}

Lasit change: admin changed from Editing Translated Version o Reviewing Translated Version on Tuesday, Apei 25, 2017
Comments: More =

Previews Open Diff Publsh Raject

a Cool-o-matic - (Japanese (Japan), version 2)

Last change: admin changed from Editing Translated Viersion io Reviewing Translated Viersion on Tuesday, Apei 25 2017
Comments: More -
Preview Open Diff Publish Reject

( Publgh (selected) Pubizh (al) Rejgel (zelecied) Reject (al) )

The screen capture shows the Reviewing Translated Version workflow state expanded. In this state,
the Publish and Reject actions are available.
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Note: The available actions depend on the workflow state. Refer to the table in "Changing the Workflow
State of Individual Content Items" on page 83 for a list and description of actions you can perform on
content items in different states of the CT3 Sample Workflow workflow.

Click the icon in the toolbar for the action you want to perform.

Tip: Click the Toggle checkboxes icon to toggle your check box selection.

6.7 Viewing the History of Workflow-State Changes to a Content Item

Y

1.

ou can view the history of workflow-state changes to a content item.

Ensure that the section for the workflow to which the content item is assigned is displayed in the Workbox. If
it is not displayed, select the corresponding check box in the Workflows section of the Workbox ribbon. For
details, see page 79.

Ensure that the section for the workflow to which the content item is assigned is expanded. If it is not
expanded, click & to expand it.

Ensure that the section for the workflow-state section to which the content item is assigned is expanded. If it
is not expanded, click [:3|, or click the title of the section, which is the name of the workflow state, to expand
it.

In the workflow-state section, locate the content item whose history you want to view.

To view the history of workflow-state changes to a content item, click More.

|7] .Ipl About-Us - (Japanese (Japan), version 2)
Last change: admin changed from Editing Translated Version to Reviewing Translated Viersion on Tuesday, Aprl 25, 2017

Comme nta

A window opens, displaying information about each change in the workflow state of this content item. The
information in brackets below indicates the information in the screen capture below:

# The user name of the user who changed the workflow state of this item (admin).
i The date of the change to the workflow state of this item (Tuesday, 2April 25, 2017).

Tip: Use the scroll bar to scroll to the right side of the window, which displays the date.

i The previous and new workflow state. When an item is created, ITtem createdis displayed.

admin

Changed from Editing Translated Version to Review

6. When you are done viewing the history of the item, click the Close box (X) in the top-right corner to close the

window.
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6.8 Comparing Multiple Versions of a Content Item

You can compare multiple versions of a content item.

1.

Ensure that the section for the workflow to which the content item is assigned is displayed in the Workbox. If
it is not displayed, select the corresponding check box in the Workflows section of the Workbox ribbon. For
details, see page 79.

Ensure that the section for the workflow to which the content item is assigned is expanded. Ifit is not
expanded, click & to expand it.

Ensure that the section for the workflow-state section to which the content item is assigned is expanded. If it
is not expanded, click [:3|, or click the title of the section, which is the name of the workflow state, to expand
it.

In the workflow-state section, locate the content item whose versions you want to compare.

Under the content item, click Diff ‘).

Note: This is not meaningful for version 1 of a content item.

1 & About-Us - (Japanese (Japan), version 2}

Lasi change: admrin L"|'3"Igl'.—l: fram Eﬂl!il'lg Tranzlated Version 1o RE\'ieWil'lf_.l Tranzlated Version on TJ&&I’:E}' Apri 25, 2017
Comments: More
Pranmew _E?@ ubksh Rejact

The Compare Versions box opens, displaying the newer version in the left column, and the older version in
the right column. The differences are displayed in blue bold.
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Compare Versions

In the dr ) mEnus, Selec

Omne column Two columns

Breadcrumb Tithe:

Huwxx X x

Menu Tithe:

Huuxx X x

Wenu Toolip:

Page Title and Text

the:
Ko X x

ext:

Hoow oo B0 M OO0 M
OO, DO, RO XN
PO DU, MO
MO, BN MOCMCROENN OOK NN
NEXEN NN MNNX MNEXEN MNNNXXN XN
NEE KX MK K000 KN,

Breadcrumi L

Breadcrumb Tite:
BESICOLT

Menu Tithe:

BikkilconT

Manu Tooltip

|

Title:

BEsIE2LT

Text:

AR B0EIrasEI2DED
T THRER TS MELOE
L TOEK. A rROoRL-0R
BoESCMTOREERNT
D,

W

6.8 Comparing Multiple Versions of a Content Item

b To view different versions of this content item, select the version numbers from the dropdown lists at the

top of the box.

¥ To collapse a section, click the collapse button |3|.

k' To view the differences between versions of this content item in a single column, click One Column in the

top-left corner of the box.
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Compare Versions

Umne column I'wo columns
L
2 Nt 1 L d
Breadcrumiby L
Breadcrumi Title

Moo Wik el ool T x

Menu Tithe:
Woooo K- lo ol T x

Menu Tooltip:
Page Title and Text L
Tithe:

Moo Kl deB ool x

Tent:

Moo - [ p—

Toiald, Ao oil@8 ol |- cnHEETH I SIS,
AN MO0 XN MO0 3O M0N0 M0N0 OO K00 IO0OCNCNNINK
EEXNNNE, NN MMM, N MMNNXNEN NN NN NN NN NN NN

MMM MUK BN N COCM NCNCUNON NN N,

L

The new text is displayed in green bold.

The old text is displayed in red bold with strikethrough.

k' When you are done, click OK to close the Compare Versions box.
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7 Reviewing Translated Content

After your translation providers translate your content, the Connector automatically delivers it back into
Sitecore. Each translation is available in the correct language version for each item. When the translated content
returns from translation, its workflow state is Reviewing Translated Version.

To view translated content in Sitecore 6 and 7:
1. Navigate to the content item whose translation you want to view.

2. In the Sitecore Content Editor ribbon, click the Review tab.

3. Inthetop-right corner of the Content tab, click the flag icon representing the default source language.

The Language list opens, displaying all the available target languages. Under each language is the number of

available versions for each language.

e 1=
English : English X - |
; 1 version. Englich

:_: Danish : dansk E
1 version

Dutch (Hetherlands) : Nederlands (Nederland)
0 versions.

5 German (Germany) : Deutsch (Deutschland)
1 version.,

Spanish (Spain) : espafiol (Espafia)

1 version.

B W Franch (France) : francais (France)
4 Hil

&

n More Languages

4. Select the desired target language from the list to view the translation. By default, the latest version of the

translation is displayed.

5. Optional. To view a different version of the translation, click the version icon, to the right of the flag icon, and

/ e - :.:"I 1= }
2. Modfied 1162013 2:51 PM by sitecore)jennifer. | Version 2 of 2

select the desired version to view.

1. modified 3/4/2009 9:32 AM by sitecore\admin,

Wﬁmﬂwm

W Add Version

The translation of the content item is displayed.
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6. Scrolldown to review the translated content.

7. Inthe Workflow section of the Review tab, either approve or reject the translation:

Analyze Pubsizh Versions Configure Presentation Sequrity View CTC Tranglation My Tioolbar

H ? @ -ﬁ 'Ei {‘3 . D {[ Click Edit to lock and edit this item, |8 EdR

M',.'l‘tura SF History \

# To approve the translation, click the Publish button. Its workflow state immediately changes to Done.
The translated content may be immediately available for publishing, depending on your workflow
configuration and whether the Done state is configured as publishable.

i To reject the translation, click the Reject button. The workflow state changes to Reviewing, and the
translation status remains Completed.

To view translated content in Sitecore 8:
1. Navigate to the content item whose translation you want to view.
2. In the Sitecore Content Editor ribbon, click the Review tab.

3. Inthetop-right corner of the Content tab, click the default-source-language button.

The Language list opens, displaying all the available target languages. Under each language is the number of
available versions for each language.

- English= 2w

| English : English

2 versions

German (Germany) : Deutsch (Deutschland)
8 versions

French (France) : frangals (France)
G versions

Japanese (Japan) : B¥E (BF)

2 varslons

Chinese (Simplified, PRC) : dasr(dhfh A Bt 0[E])

0 versions

@  More languages

4. Select the desired target language from the list to view the translation. By default, the latest version of the
translation is displayed.
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5. Optional. To view a different version of the translation, click the version button, to the right of the default-
source-language button, and select the desired version to view.

- Garman -

8. Modified 412016 12:57 PM by sitecorewirtualssuser e -
Version B of 8.

—

7. Modified 41/2016 11:46 AM by sitecorewirtualssuser.
G.  Modified 41/2016 10:41 AM by sitecore\viriualssuser
5. Modified 412016 9:50 AM by sitecoreWirlualssuser.
4. Modified 412016 5:30 AM by sitecoreWirtualssuser,

3. Modified 3/29/2016 11:40 AM by sitecorewirtualssuser

2 Modified 31472016 5:14 PM by sitecore\Anonymous

The translation of the content item is displayed.
6. Scroll down to review the translated content.

7. Inthe Workflow section of the Review tab, either approve or reject the translation:

HOME NAVIGATE REVIEW ANALYZE PUBLISH VERSIONS CONFIGURE PRESENTATION SECURITY VIEW CTC TRANSLATION MY TOOLBAR

ARS - ) " = . ~ B e
H 157 Q :g e d :‘1‘ Click Editto lock and edit this tem. - Edit & Publish .é,:} @
Save Spelling Markup Validation Subscribe » SEOQ Analysis My items ' History &) Reject Reminder =  Archive -

To approve the translation, click the Publish button. Its workflow state immediately changes to Done.
The translated content may be immediately available for publishing, depending on your workflow
configuration and whether the Done state is configured as publishable.

To reject the translation, click the Reject button. The workflow state changes to Reviewing, and the
translation status remains Completed.
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8 Post-Translation Features

8.1 Archiving Completed Jobs

After the translation is complete, approved, and published, you can perform the following additional optional

tasks:

Task Description Details

archive If you are assigned to the sitecore\Translation Administrator role, you page

translation can archive completed jobs. 93

synchronize If a content item has been translated into multiple target languages, and you page

translation updated only one target language, you can use this feature to update additional 95
target languages.

request a If you find a mistake in the translated content, you can send a request to the page

translation translation provider to correct the translation and resend it. 97

correction

updatea You can update a remote TM (translation memory) server, used by your page

remote TM translation provider, with your latest changes to the translated content. 100

server

clear the You can clear the translation backup database. This database supports the page

translation following features: Translation Correction, Update Remote TM, and 106

backup data SyncTranslation.

8.1 Archiving Completed Jobs

You archive a translation job so that it will no longer be displayed in the Translation Status window.

Typically, you archive a translation job after all its assets have been translated and approved, when it is inactive,
which means it has Completed status.

Recommendation: Archive only completed jobs. If you archive a job that is in progress (for example, with In
Translation status), then the Connector will no longer process the content items in that job.

For a list and description of job statuses, see "Translation Statuses" on page 69.

Only users who are assigned to the sitecore\Translation Administrator rolecan archive jobs.

To archive a job:

1. Do one of the following to open the Translation Status window:

In the Sitecore Content Editor ribbon, click the CTC Translation tab, and then in the Translation Tools
section, click Translation Status.
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HOME NAVIGATE REVIEW ANALYZE PUBLISH VERSIONS CONFIGURE PRESENTATION SECURITY VIEW CTC TRANSLATION MY TOOLBAR

Icl Bulk Translation [@] Translation Queus i Clear backup data

1| Translation Filter [#) Translation Status «| Item Translation Details

In the Sitecore Desktop, click the Sitecore menu, and then select All Applications > CTC Translation >
Translation Status from the menu. (Sitecore 6 and 7 only)

The Translation Status window opens. For a detailed description of this window, see "Monitoring Status for
Multiple Items" on page 71.

Translation Status O X
@S : Q@ & ™, @2
Open Selected hems Update Remote TM Archive Job Refrash
iDrag a column to this area to group by it Search:
icontentHome sa-N 30 Mew Translation ba827200-8034-43ad-alB-dacs9d02edB1  senttoLsP @ B3 01M7L
fcontentHome ja-JP 5 o Mew Translation 4de564fa-cdc-4ced-b705-65¢21bb 17320 Sent to LSP o 2] VA1) A
fcontentHome/About-Us/Our-History fr-FR 1 'o New Translation  debf3106-a37b-4e81-a47a-eed287613b01e Completed [100% | 0178
icontentHome/About-Us/Our-History ja-JP 3 o MNew Translation b8TBd4ba-7279-4cbe-b177-3/580188ec5a Completed [100% | 01M85
icontentHome/About-Uis fr-FR 3@ New Translation 0Ob7cOebd-1cc8-4TdG-a77a-7d3aBl45ae87  Completed [100% | 01M8L
fcontentHomea/About-Us/Our-History sa-IN 1 i ] MNew Translation b2a30376-4all-4243-ac1a-90846326a736  Completed 01185
fcontentHomea/About-Us sa-IN 1 n MNew Translation b2a30376-4a13-4243-ac1a-90846326a736  Complatad 100% 011854
feontentHaome/About-UsiOur-History fr-FR 5 'n Mew Translation 0bT7clebd-1cc8-4TdE-a77a-7d3aB34%9a3e87  Completed [100% | 01185
icontentHome/About-Us ia-JP 10 New Translation b978d4ba-7279-4cbe-p177-3580188ec5a  Completed 100% ] 01184
icontentHome/About-Us/Our-Values fr-FR 70 New Translation Ob7cOebd-1cc8-4Td6-a77a-7d3aB349ae87  Complated 01185
fcontantHoma/About-Us/Our-Valuas la-JP 3 i ] MNaw Translaton bS78d4ba-7279-4che-p177-315801888c5a Complatad 100% 01185
fcontentHomea/About-Us/Our-Values za-IN 9 o Mew Translation b2a30376-4a13-4243-ac12-00846326a736  Completad 01185
feontentHome fr-FR 3 0 Mew Translation ced9a0fS-0e68-452d-318¢-933ca01b5sfa Complatad 100% VR i A
fcontentHome sa-IN 4 o Mew Translation 87c01f6a-c008-4 1bb-0ela-fR34fd20b5cF Sent o LSP o 53¢} Q7L -
b -

2. Select the job to archive from the Job dropdown list.

3. Click Archive Job.
A message box opens, confirming that you want to archive the specified job.
4. Click OK to proceed.

Tip: To un-archive an archived job so that it that it is active again, select it from the Job dropdown list, and click
Unarchive Job. A message box opens, confirming that you want to un-archive the specified job. Click OK to
proceed. Available only if you are assigned to the sitecore\Translation Administrator role.
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8.2 Synchronizing Translation of Other Target Languages

After a content item is translated, you can update translated versions in other target languages with changes in
the source language. This synchronizes translations of a content item in multiple target languages. This is useful
if you changed the content in the source language, and updated the translation in one target language.
However, now, you want to update the content in the other target languages. You can specify at the field level
which field types and target languages you want to update for the new content.

To synchronize the translations of a content item:

1. Navigate to the content item whose translations you want to synchronize and select it. Select an item that
meets the following criteria:

It has already been translated, so it has Completed status.
Its translation is backed up in the database, so the value in the TNS Backup column is Yes.

2. On the Sitecore Content Editor ribbon, click the CTC Translation tab.

3. In the Translation Tools section, click Iltem Translation Details.

HOME NAVIGATE REVIEW ANALYZE PUBLISH VERSIONS CONFIGURE PRESENTATION SECURITY VIEW CTC TRANSLATION MY TOOLBAR

H (2l Bulk Translation [ Translation Queue g Clear backup data

Save Translation Filter |/\ Translation Status w. Item Translation Datails

The Translation Status tab for the content item opens.

Translation Status

Translated | Translation Status Last Update
|&] fcontentHome en V1] de-DE f-FR 3M42016 2:20:37 PM [In Cueue] Wait for approval IN42016 2.20:37 PM Cweued Translation Mo
[@ fcontantHome en V1] da-DE 3/29/2016 11:39:11 AM Sending .. 3292016 11:39:11 AM Sending Translation No
[E fcontentHome en [V:1] de-DE 3292016 11:38:10 AM 1% | Sending .. 3292016 11:39:10 AM Sending Translation No
& icontentHome en V2] de-DE [V:8) 412016 125314 PM oo, | Completed AM2016 125711 PM New Translation Yeg

This tab displays translation-status information about the selected content item and any child items. For a
detailed description of this tab, see "Monitoring Status for a Single Iltem" on page 74.

4. Select an item that has already been translated. This item has Completed status.

5. Right-click, and select Synchronize Translated Versions from the context menu.

The main page of the wizard opens.
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CTC Synchronize Translation

Deiect source content changes (per field), and send changed content for ransiation so all
languages are synchronized.

You have changed the following source content fields and they require translation synchronization
Titla
Summary

« Body

Targel languages that require translation synchronization (No new Version will be created)

# German (Germany) : Dewtsch (Deutschland)

s [ cance

6. The first section displays a list of all field types in the content item that were updated, and that should be
synchronized in the translated items.

Select the check boxes for the field types for which you want to synchronize the translation.

If there are field types for which you do not want to synchronize the translation, leave the check boxes
cleared. The translations for fields of those field types will not be updated.

7. The second section displays the target languages that require translation synchronization.
Keep the check boxes selected for the target languages you want to synchronize.

If there are target languages you do not want to synchronize, clear the check boxes cleared. The
translations for these languages will not be updated.

8. Click Send.
The Connector sends the changes in the selected field types for translation in the specified languages.
Note: The Connector does not create a new version for the synchronized translations.

The summary page of the wizard opens.
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CTC Synchronize Translation wizard has completed. Click
' Finish to close the wizard.

Sant out a Synchronize Translation asset

Sent changed field content from the following fialds for translation
Body

To ensure the content of following languages is synchronized:
de-DE

Close

It displays the fields that the Connector sends for translation, and the target languages that will be
synchronized.

9. Click Finish.

The wizard closes.

8.3 Requesting Translation Corrections

If you find a mistake in the translated content, you can send a request to your translation provider to correct
the translation and resend it.

Note: If you have multiple translation providers, the Connector sends the correction request to the translator
who originally translated the content.

1. Inthe Sitecore Content Editor, navigate to the content item for which you want to request a translation
correction.

2. In the Sitecore Content Editor ribbon, click the CTC Translation tab.

3. Inthe Translation Tools section, click Item Translation Details.
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HOME NAVIGATE REVIEW ANALYZE PUBLISH

VERSIONS

CONFIGURE

PRESENTATION

8.3 Requesting Translation Corrections

'dl Bulk Transiation
A Translation Filter

[d) Translation Queue & Clear backup data

Save

[l Translation Status #) ltem Translation Details

S P 0
In Transiation: &

SECURITY VIEW CTC TRANSLATION MY TOOLBAR
Backuy
e
Compisted 21 Arcnyed [-]
Jobs (Archived) 38 (2 TT Log Files: F

m opens.

The Translation Status tab for the content ite
Content Q Translafion Status
@ Refresh

|&] fcontentHome en V1] de-DER-FR 42016 2:20:37T PM
[2 ‘contentHome en V1] de-DE 32972016 11:39:11 AM
[E] icontentHome en V1] de-DE 32972016 11:39:10 AM
& icontentHome en V2] de-DE [V:8) 42016 125314 PM

Transiated | Translation Status

[In Cueue] Wait for approval
= Sending .

1%} Sending ..

e | Completed

Last Updaie

TNS Type

IN42016 2:20:3T PM Queued Translation MNa
3292016 11:30:11 AM Sending Translation No
AR92016 11:39:10 AM Sending Translation MNo
412016 125711 PM New Translation Yes

This tab displays translation-status information about the selected content item and any child items. For a
detailed description of this tab, see "Monitoring Status for a Single Iltem" on page 74.

4. Select an item that meets the following criteria:

It has already been translated, so it has Completed status.
Its translation is backed up in the database, so the value in the TNS Backup column is Yes.

5. Right-click, and select Request Translation Correction from the context menu.

The main page of the wizard opens.
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CTC Translation Correction

Ask your ranslabon Provider to rewvise the ransiabon in e following fields.

Source Language: English : English

Target Language: German (Germany) : Deutsch (Deutschland)

Fields requiring translation corrections
Title

o Summary

« Body

Motes

Please update

Back Send = Cancal

6. The first section displays a list of all field types in the content item. Select the check boxes for the field types
for which you want to request a correction.

7. Inthe second section, Notes, enter your correction request for the translation provider.

8. Click Send.
The Connector sends the selected field types in the content item and your notes to the translation provider
as a correction request.

The summary page of the wizard opens.
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The CTC Translation Correction wizard has
“ completed. Click Finish to close the wizard.

Sent out a NeedTranslatonCormection asset

Translaton Language Pair. en ==> da-DE
Contant requiring translation comeclions from fields
Summary

Bady

Clasa

It displays the translation language pair and the field types for which you requested a translation correction.

9. Click Finish.

The wizard closes.

8.4 Updating a Remote Translation Memory (TM)

After the Connector returns the translated content from your translation provider to Sitecore, in- country
marketers or reviewers can review the translation, as described in "Reviewing Translated Content" on page
90These reviewers can then send their post- translation updates to their translation technology or provider,
who can then update the translation memory (TM) with these content updates. This means that the updates
will be available to the translation provider for subsequent translations, which makes the translation process
more efficient. Your translation provider's TM (translation memory) server is a remote TM.

Your changes will be copied to the UpdateTM folder that resides on your translation provider's FTP server.

Note: This feature is available only with the Clay Tablet FTP Connector. The location of the remote TM server is
specified by the TNS UpdateTMFolder setting in the FTP configuration file, which is configured by CTT.

To send updates to the translation provider's translation memory(TM), you do one of the following:
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You send updates for a single item from the Content Editor, in the Translation Status tab for the item, as
described in "Updating a Remote TM for a Single Item" on page 101.

Note: When you send updated content from a single item to update a remote TM, you can specify which
field types to send.

You send updates for multiple items in a single translation job from the Connector's Translation Status
window, as described in "Updating a Remote TM for Multiple Items" on page 103.

The Connectors sends an XML file to the translation technology or provider with the updates. This file includes:
the original source content
the original translated content

the updated translated content

Best practices for updating a remote translation memory (TM):

Make only small post- translation updates in the Sitecore authoring environment, and then use this feature
to send those updates to the translation provider. If you require large updates or rewrites, discuss this
directly with your translation provider to ensure that all changes are captured efficiently. In this scenario, the
translation provider can redo the translations and redeliver the updates via the Connector.

Create a primary review process for translation that captures most changes to translated content, so that
the translation provider can update its TM directly. The secondary review process in Sitecore then captures
only small and minor post- translation updates.

A project manager at the translation provider should review the suggested updates and ensure that the
translation memory is updated with these changes.

Important: Updating the remote TM is not an automatic process. The translation provider must review all the
changes and transform them into a format to update the TM. The translation provider may charge a service fee
for this work.

8.4.1 Updating a Remote TM for a Single Item

You can update a remote TM server for a single item, as described below. For instructions on updating a remote
TM server for multiple items from a single translation job, see page 103. For general information about updating
aremote TM server, see page 100.

1. Inthe Sitecore Content Editor, navigate to the content item for which you want to send updated translation
content to a remote TM.

2. In the Sitecore Content Editor ribbon, click the CTC Translation tab.

3. Inthe Translation Tools section, click tem Translation Details.
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8.4 Updating a Remote Translation Memory (TM)

HOME NAVIGATE

REVIEW ANALYZE

PUBLISH VERSIONS

H [dl Bulk Translation [ Translation Quewe g Clear backup data

Save Il Transiation Filter [ Translation Status | Item Translation Details

CONFIGURE

PRESENTATION SECURITY VIEW CTC TRANSLATION MY TOOLBAR

The Translation Status tab for the content item opens.

Translation Stalus

Translated
|&] fcontentHome en[V:1] de-DE f-FR 342016 2:20:37 PM
[8 fcontentHome en [V:1] de-DE

3292016 11:39011 AM

=] icontentHome en V1] de-DE 32092016 11:39:10 AM 1% |

& icontentHome enva] de-DE [V:8] 472016 125314 PM iogs |

Translation Status Last Updaie

[In Cueue] Wait for approval AN42016 2.20:37 PM Cueusd Translation Mo

3292016 11:30:11 AM Sending Translation No

AR92016 11:39:10 AM Sending Translation MNo

4MR0I6 125711 PM New Translation Yes

This tab displays translation-status information about the selected content item and any child items. For a
detailed description of this tab, see "Monitoring Status for a Single Iltem" on page 74.

4. Select an item that meets the following criteria:

It has already been translated, so it has Completed status.
Its translation is backed up in the database, so the value in the TNS Backup column is Yes.

5. Right-click, and select Send Post-Edited Content to Update a Remote TM from the context menu.

The Update a Remote Translation Memory Server page of the wizard opens.

Update a Remote Translation Memory Server

O X

Send updaied field content from this item fo a remole TMS lo update its Translalion Memaory,

Sowrce Language: English : English
Target Language: German [Germany) : Deutsch (Deutschiand)

Select fields with post-adited content to update a remaote TM
Price Details

« Tille
Description

Back m Cancel
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6. The source and target languages are displayed. The main section displays a list of all field types in the
content item. Select the check boxes for the field types that you want to send to the remote TM server.
7. Click Send.
The Connector sends the content from the selected field types to the remote TM server.

The summary page of the wizard opens.

The CTC Update TM wizard has completed. Click Finizh
to close the wizard.

Sent out an UpdateTM asset

T™ Language Pair: en === de-DE

Past-edited content from flelds:
Title

Cloza

It displays the translation language pair and the field types for which the Connector sends content to the
remote TM server.

8. Click Finish.

The wizard closes.

8.4.2 Updating a Remote TM for Multiple Items

You can update a remote TM server for multiple items from a single translation job, as described below. For
instructions on updating a remote TM server for a single item, see page 101. For general information about
updating a remote TM server, see page 100.

1. Do one of the following to open the Translation Status window:

In the Sitecore Content Editor ribbon, click the CTC Translation tab, and then in the Translation Tools
section, click Translation Status.

NAVIGATE REVIEW ANALYZE PUBLISH VERSIONS CONFIGURE PRESENTATION SECURITY VIEW CTC TRANSLATION MY TOOLBAR

Icl Bulk Translation [ Translation Queue g ‘Clear backup data

1| Translation Filter [#) Translation Status «| Item Translation Details
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In the Sitecore Desktop, click the Sitecore menu, and then select All Applications > CTC Translation >
Translation Status from the menu. (Sitecore 6 and 7 only)

The Translation Status window opens, displaying the translation status of all content items that you
submitted.

Translation Status O X
= . . i < — &
Open Selected ltems Update Remote TM  Archive Job Refresh
[Drag a column to this area to group by It Search:
leontentHome sadN 10 Mew Translation ba827209-8034-43a4-al0B-dac59d02e481  SenttoLSP @ B1 0N
feontentHome ja-JP 5 o Mew Translation 4de564fa-cdci-4cad-b705-65¢21bb 17320 Sent to LSP o f52%] "R 1 A
fcontentHome/About-Us/Our-History fr-FR 1 'o Mew Translation debf3106-a37b-4e81-a47a-eed87613b01e Completed [100% | VR L A
icontentHome/About-Us/Our-History ia-JP 10 New Translation b9T8d4ba-T279-4che-b177-31580188ec5a  Completed 100% 01185
icontentHoma/About-Us fr-FR 16 Mew Translation ObTcOebd-1cc8-47d6-a77a-Td3a83493e8T7  Completed [100% | 01185
fcontentHoma/About-UsiOur-History sa-IN 1 ﬂ Mew Translation b2a30376-4a13-4243-ac13-99846326a736 | Complatad [100% 01M8xL
fcontentHome/About-Us sa-IN 1 o MNew Translation b2a30376-4ai3-4243-ac13-90846326a736  Completed 011875
fcontentHome/About-Us/Our-History fr-FR 5 '0 MNew Translation 0b7clebd-1cc8-47d6-a77a-7d3af3409ae87  Completed [100%e | 011875
fcontent’Home/About-Us ja-JP 3 o Mew Translation b978d4ba-7279-4che-b177-3580188echa Completed [100% | 01185
icontentHome/About-Us/Our-Values fr-FR 70 New Translation 0Ob7cOebd-1cc8-4Td6-a77a-7d3aB345ae87  Completed [100% | 01M8s
fcontentHomea/About-Us/Our-Values |a-JP 3 i ] MNew Translation bS78d4ba-7279-4che-b177-31580188echa Complated [100% | 01185
fcontantHoma/About-Us/Our-Valuas sa-IN 1 o MNew Translation b2al0376-d4a13-4243-ac1a-90846326a736  Complatad 100% 01184
feontentHame fr-FR 3 'o Mew Translation ced9a0fB-9e68-452d-a18c-933cad1bhfa Complatad 100% iR i A
fcontentHome sa-IN 4 'o MNew Translation 87c01f6a-c008-41bb-OeDa-fB34fd20b5cF Sent to LSP o %] Q7L =
1]

For detailed information about the Translation Status window, see "Monitoring Status for Multiple Items"
on page 71.

2. Select the job from with the items to send to the remote TM server from the Job dropdown list.

3. Select the items to send to the remote TM server.

Tips: Use the Shift key to select a range of adjacent items. Use the Ctr1 key to select multiple non-
adjacent items.

4. Click Update Remote TM.
The Settings page of the wizard opens.
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Settings 0 X

Select fhe target languages fo update remate TM. Then click Next o prepare for remote TM update

Source Languague(s)

en (English : English}

Target Language(s)
de-DE German (Germany) . Deutsch (Deutschland
fi-FR  French (France) . francais (France

Back Mext Cancel

5. The source and target languages are displayed. Select the check boxes for the target languages that you
want to send to the remote TM server, and click Next.

The Preparing page of the wizard opens.

Preparing

Preparing items for remote TM update. Click Mext to send out remaote TM update

Are you sure you wanf to update remote TM for 1 completed items with post-edit changes?

This page displays the number of items to send to the remote TM for updating.

Notes: If there are items in the job that have not been translated yet, a message displays this. If there are no
items that have been modified after translation, a message states: There is no item with post-edit
changes that require TM update.

6. Click Submit.
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The Connector sends the content from the selected items to the remote TM server.

The summary page of the wizard opens.

Batch Remote TM Update wizard has completed. Click
“Finish" to close the wizard.

Remote TM update has been sent out for 1 items of job
Mew Jobin 1 files

Close

It displays the number of pages and the translation job name that the Connector sent to the remote TM
server.

7. Click Finish.

The wizard closes.

8.5 Clearing Backup Data

You can delete all the backup data used by the following Connector translation features: Translation Correction,

Update Remote TM, and SyncTranslation. You can delete the backup data from either the Sitecore Content
Editor or the Sitecore Desktop.

1. Do one of the following to open the Translation Data Cleanup wizard:

¢ In the Sitecore Content Editor ribbon, click the CTC Translation tab, and then in the Translation Tools
section, click Clear Backup Data.

HOME NAVIGATE REVIEW ANALYZE PUBLISH VERSIONS CONFIGURE PRESENTATION SECURITY VIEW CTC TRANSLATION MY TOOLBAR

\el Bulk Translation [&] Translation Queus g Clear backup data

@
Gl Translation Fitter  [&) Translation Status #) Item Translation Details

In the Sitecore Desktop, click the Sitecore menu, and then select All Applications > CTC Translation >
Clear Backup Data from the menu. (Sitecore 6 and 7 only)

The Delete CTC Translation Backup Data page of the wizard opens.
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Delete CTC Translation Backup Data

Delete all backup data used by the CTC translation features.

The “Clear Backup Dafta” featura will free some database and hard drive space, but saveral useful features,
like 'Update remote TN, Translation Correction” and "Synchronize Translation’, reguire this data and WILL
MO LONMGER WOREK for all previous translation projects if you delate it

Delete backup data

# Backup item translations
#| Translation Logs

Archived jobs

Back m Cancel

2. Select the types of backup data to delete:
Backup item translations: Individual content item translations at the field level.
Translation logs: Log files of all the events that occurred in a translation job.

Archived jobs: Data in archived jobs.

3. Click Clear.

A warning message box opens.

Message X

Are you REALLY sure? Erasing this data will
make several features unusable for all
projects previous to the date of data erasure
Only proceed if you (and all other transiation
stakeholders) are confident this is what you
want to do

4. Ifyou are sure you want to delete the backup data, click OK.

The summary page of the wizard opens, displaying the number of each type of backup file you deleted.
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The CTC Translation Data Cleanup Wizard has completad,
Click Finish to close the wizard.

A total of 2 ranslation log files have been deleted

Close

5. Click Finish to close the wizard.
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